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Specificaties MyPal A639

Processor Marvell® PXA 270-processor, 416MHz
FESTIESECE LM Microsoft® Windows Mobile® 6 (Pocket PC)
Geheugen 1GB Flash ROM

64MB SDRAM
Beeldscherm 3,5", briljant transflectief TFT-LCD

65.000 kleuren

QVGA, LCD Touchscreen met 240x320

resolutie
Batterij 1300 mAh vervangbare/oplaadbare Li-ion
Uitbreidingssleuf SD-kaartsleuf (SDIO/SD/MMC)
Communicatie Bluetooth® v2.0 (EDR)

IR-poort: SIR 115.2kbps max USB 1.1 Client
WLAN 802.11b/g

3.5 mm stereo

SiRF Star [1l / GPS-chip met ingebouwde
GPS-antenne

Grootte 122 mm x 73.2 mm x 18.8(19.45) mm
Gewicht 187 gram (met batterij)

(De specificaties zijn onderhevig aan wijzigingen zonder voorafgaande kennisgeving.)

Belangrijk  Om schade aan uw Pocket PC en zijn accessoires
te voorkomen, is het best dit apparaat (inclusief de
beschermhoes) te gebruiken binnen een temperatuurbereik
van 20-30°C (68-86°F) en bij een vochtigheid van maximaal
50% te gebruiken. Alle omstandigheden boven of onder de
ideale temperatuurbereik kunnen het toestel beschadigen en
de levensduur van de batterij verkorten.

OPMERKINGEN Op verzoek van Microsoft Corporation hebben wij het
programma Microsoft® Outlook van de cd Aan de slag
voor Windows Mobile® 6 verwijderd. Het programma
Microsoft® Outlook 2002/2007 software moet afzonderlijk
worden aangeschaft.
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Inhoud verpakking

Uw verpakking bevat verschillende accessoires voor de Pocket PC.
Controleer de items na het uitpakken met de onderstaande lijst en
controleer of ze in goede toestand zijn. Als er items ontbreken of
beschadigd zijn, moet u onmiddellijk contact opnemen met uw verkoper of
leverancier.

Standaarditems

+ ASUS MyPal A639 Pocket PC
+ USB-synchronisatiekabel
+ Adapter

+ Microsoft Getting Started CD (Microsoft-cd Aan de slag):
bevat Microsoft® ActiveSync® 4.5 of later

« Pen
+ Beschermhoes
+ Vervangbare/oplaadbare 1300mAh Li-ion-batterij

+ Handleiding

+ Snelstartgids

+ Carkit (autohouder en zwanenhals)

+ Autolader

+ Garantiekaart

+ Cradle

+ Pen x3/pakket + Autolader en convertor
+ Adapter 26-pins naar gelijkstroomingang

+ Externe antenne + Batterij

+ USB-synchronisatiekabel + Leren beschermhoes
+ Adapter

+ Carkit (autohouder en zwanenhals)
+ Bluetooth toetsenbord

+ Stereo headset met microfoon

+ Bluetooth-headset




Hoofdstuk 1 Aan de Slag

Kennismaken met MyPal

De ASUS® MyPal A639 is een fantastische partner, waar u zich ook
bevindt. Dankzij zijn uitrusting met een 416MHz Marvell® PXA270-
processor, 64MB SDRAM en 1GB Flash ROM en het besturingssysteem
Microsoft® Windows Mobile® 6 samen met een groot aanbod nuttige
hulpprogramma’s, hebt u alles wat u nodig hebt in uw zak!

MyPal A639 wordt geleverd met de extra WiFi-functie waarmee u een
verbinding kunt maken met een draadloos LAN en met het internet. MyPal
A639 heeft één SD-kaartsleuf.

Voorkant
Voedings-/Meldings-LED LED Bluetooth/Wi-Fi/GPS
LCD Touchscreen
Startknop Knop Contactpersonen
Knop Agenda
Luidspreker
Knop Notities
o Knop Modus-/
4-weg navigatieknop ———— Takenschakelaar

+ Voedings-LED - toont een stabiel rood lampje wanneer de batterij wordt
opgeladen en een stabiel groen lampje wanneer de batterij volledig is
opgeladen en het apparaat op een wisselstroombron is aangesloten.

+ LED Bluetooth/GPS/Wi-Fi - licht blauw op wanneer de Bluetooth® -
functie is ingeschakeld, licht groep op wanneer de GPS is ingeschakeld
en licht rood op wanneer WiFi is ingeschakeld.

+ LCD Touchscreen - via dit scherm kunt u gegevens openen,
lezen, verzenden, ontvangen of bewerken door erop te tikken. De
schermverlichting wordt verhoogd of verlaagd door de instellingen voor
de achtergrondverlichting aan te passen.

Aan de Slag!



Achterkant

Luidspreker - via de luidspreker kunt u alarmsignalen of andere
geluidsuitvoer van het apparaat horen.

4-weg navigatieknop - werkt als de vier pijlen op een toetsenbord.
Met deze knop kunt u zich door de programmapictogrammen, mappen
of bestanden in een menu verplaatsen door omhoog, omlaag, naar
links of naar rechts te schuiven.

Als ASUS® MyPal is geleverd met GPS-kaartensoftware, kunt u de
knoppen gebruiken om in en uit te zoomen en het volume te regelen.
Startknop - werkt als de toets Enter/Return op een toetsenbord. Druk
eenmaal op deze knop om een geselecteerd programma te starten, de
inhoud van mappen weer te geven of een bestand te openen.

Knop Contactpersonen - hiermee kunt u op elk ogenblik uw lijst met
contactpersonen openen.

Knop Agenda - hiermee kunt u op elk ogenblik het programma
Agenda openen.

Knop Modusschakelaar - hiermee kunt u schakelen tussen de
schermen Vandaag (Today), Windows Media Player en Draaien
(Rotate). De knop Modusschakelaar kan ook werken als een
Takenschakelaar, zodat u kunt schakelen tussen de momenteel
geopende programma’s op uw apparaat.

Knop Notities - hiermee kunt u op elk ogenblik het programma Notities openen.

@ — QW Pen
] GPS-antenne
o

L @7 Vergrendelingsknop

— Batterijklep

Pen - wordt gebruikt om te tikken of te schrijven op het LCD Touchscreen.
GPS-antenne - wordt gebruikt als een signaalontvanger die uw exacte
locatie vaststelt. Deze informatie wordt opgehaald van satellieten. Plooi
dit paneel open wanneer u de GPS gebruikt. Als de signaalontvangst
niet sterk genoeg is, kunt u een optionele antenne aansluiten op de
aansluiting op de bovenkant van dit paneel.

Vergrendelingsknop - biedt een veiligheidsmaatregel die verhindert
dat gebruikers per ongeluk op het scherm tikken of het apparaat
inschakelen. Schuif de knop naar het woord Hold om het scherm uit te
schakelen en te verhinderen dat het opnieuw wordt ingeschakeld, zelfs
wanneer u op het scherm tikt of op een knop drukt. Schuif de knop in

de tegenovergestelde richting om deze functie uit te schakelen.
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+ Batterijklap - biedt bescherming voor het batterijvak van het apparaat.

OPMERKING Als voorzorgsmaatregel wordt de aan/uit knop
automatisch uitgeschakeld wanneer u de
achterklep verwijdert. U kunt de voeding pas opnieuw
inschakelen wanneer de achterklep op het apparaat
is geinstalleerd. De batterijklep is afneembaar en
biedt u de mogelijkheid de hoofdbatterij te verwijderen of
te vervangen. Zie “MyPal instellen” voor details.

Zijkant

+ Infraroodpoort (IR) - hiermee kunt u gegevens kopiéren of verzenden
naar een ander apparaat met een IR-poort. Voor een succesvolle
uitwisseling van gegevens moeten de IR-poorten op beide apparaten
correct zijn uitgelijnd en naar elkaar gericht zijn binnen het bereik van
de IR-communicatie.

~

| E—'f Infraroodpoort (IR)

Bovenkant

Pen Klep voor externe antenne

buﬂl M

( )

) [C(—% j

=

Aan/uit knop SD-kaartsleuf
(SD/SDIO/MMC)

+ Klep VOOR externe antenne - dekt de poort voor de externe antenne
af. Als het GPS-signaal zwak is, kunt u een optionele externe antenne
aansluiten op deze poort.

+ SD-kaartsleuf - biedt plaats aan een SD-geheugenkaart, een MMC-
geheugenkaart of een SDIO-interfacekaart (bijv. 802.11b/g, modem,
enz.)

Aan/uit knop - schakelt de voeding van het apparaat aan of uit als u de knop
snel indrukt.

Aan de Slag!



Onderkant

Aansluiting synchronisatie- en
voedingskabel

@RESET

N

Reset-schakelaar

Aansluiting hoofdtelefoon

Aansluiting hoofdtelefoon - hier kunt u de hoofdtelefoon aansluiten.

Aansluiting synchronisatie- en voedingskabel - sluit de 26-pins USB-
synchronisatiekabel rechtstreeks aan op deze aansluiting om uw apparaat met uw
computer te synchroniseren. De batterij wordt ook op hetzelfde ogenblik opgeladen.
Reset-schakelaar - hiermee kunt u een softwarematige reset uitvoeren in

geval het apparaat niet correct werkt of als een toepassing vastloopt. Duw met
de punt van de pen op deze schakelaar om het systeem opnieuw in te stellen.

OPMERKING Wanneer u een hardwarematige
reset wilt uitvoeren, houdt u de knop
Volume lager :: ingedrukt terwijl
u tegelijk Modusschakelaar !
indrukt en met de pen op de reset-
schakelaar drukt. Daarna wordt een
waarschuwingsbericht weergegeven.
Druk op (I om een hardwarematige
reset uit te voeren of druk op & om
het bedieningsscherm ongewijzigd te
laten.

Zorg dat u alle bestanden op de
opslagkaart decodeert voordat u een
hardwarematige reset uitvoert. Als

u dat niet doet, zullen de bestanden

mogelijk niet opnieuw kunnen worden

geopend na de hardwarematige
reset.

De GPS-carkit
De GPS-carkit bevat:

/N WAARSCHUWING!

BTER VErVICEN U dla mElngen

r b starcion v bt %
Trrg anvon: dit il bastarcin

o geheugankaat ontdeutelt A
) e slandardinstabrger

it bt s v s 0l

= Wit ey ey da stancsmioe

stellrg var et sestesm, dik

dan op) S

= Wik u daze pacia vedaten druk
dar opy 5},

+ Autohouder - houdt de Pocket PC op zijn plaats.
+ Zwanenhals - bevestigt de Pocket PC veilig op de voorruit van de auto.

Hoofdstuk 1



De batterij installeren en verwijderen

OPMERKING Wanneer u de batterijklep opent, wordt de voeding
automatisch uitgeschakeld. Bovenaan links op het
batterijvak bevindt zich een mechanisme dat de
voeding automatisch uitschakelt wanneer u de
batterijklep uitschuift. Dit is een veiligheidsmaatregel
voor het beschermen van het stroomcircuit. Zorg er
dus voor dat u de batterijklep niet verliest.

Aansluiten op een Adapter

BELANGRIJK U moet de batterij opladen voordat u het apparaat voor
de eerste keer gebruikt.

26-pins apparaatstekker
Adapter
synchronisatiekabel

Adapter / voedingskabel

OPMERKING Zodra de voedingskabel is aangesloten op een
Adapter, wordt het opladen van de batterij gestart en
toont de voedings-LED een stabiel rood licht. Zie “De
instellingen voor het batterijvermogen wijzigen” in
hoofdstuk 2 voor meer informatie over de manier waarop u
de vermogensstatus van de batterij kunt weergeven.

Aan de Slag! 5



De GPS instellen

Een GPS-signaal ontvangen:

Kantel het paneel van de GSP-antenne op de achterkant van het apparaat
open. U kunt het paneel draaien zoals onderaan rechts weergegeven.

OPMERKING Voor de beste signaalontvangst, moet het GPS-antennepaneel
parallel met de grond worden georiénteerd. Als de GPS-
signaalontvangst zwak is, kunt u een optionele externe antenne
aanschaffen en gebruiken. Kantel de antenneklep boven het paneel
open en sluit de externe antenne aan op de antennepoort.

De GPS-carkit gebruiken:

Verticale stand Horizontale stand

OPMERKING Wanneer u de stand aanpast, moet u de
zwanenhals voorzichtig aanpassen. U mag deze
nooit forceren. Het apparaat moet voorzichtig in de
houder worden geplaatst om te vermijden dat de
26-pins apparaataansluiting beschadigd wordt
waardoor het apparaat mogelijk niet meer zal werken.
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Extra opslagruimte

MyPal A639 is voorzien van een standaard SD-kaartsleuf. In de SD-
kaartsleuf kunnen SD- of MMC-geheugenkaarten worden geplaatst. Dit
ondersteunt ook SDIO-kaarten met verschillende functionaliteiten, inclusief
802.11b/g, modem, enz.

Een SD/MMC/SDIO-kaart installeren en verwijderen

1. Plaats de kaart met de labelzijde omhoog Label

(doorgaans de zijde met de naam van de
kaartfabrikant) en de zijde met de barcode/ ‘ !
het serienummer omlaag gericht in de SD-
= e —

kaartsleuf die zich op de bovenkant van het
apparaat bevindt.

2. Duw de kaart volledig in de sleuf tot deze stevig
op zijn plaats zit. Als de SD- of MMC-kaart
correct is geinstalleerd, vormt de rand van de
kaart één lijn met de bovenste rand van het
apparaat. Bij SDIO-kaarten steekt er meestal
een stuk uit over de rand van de sleuf.

3. Om de kaart te verwijderen, drukt u licht op de
kaart tot deze uit de sleuf springt. Daarna kunt
u de kaart veilig verwijderen.

OPMERKING Een SD/MMC/SDIO-kaart past
slechts in één richting en als u
de kaart correct plaatst, moet deze
vlot in de sleuf schuiven. Forceer de
kaart NIET in de sleuf!

Aan de Slag!



MyPal activeren

Voordat u het apparaat kunt gebruiken, moet u het correct kalibreren en
activeren. Dit proces zorgt voor een nauwkeurige positionering wanneer u
tekst invoert en menu’s selecteert.

Uw apparaat kalibreren en activeren

1. Druk op de aan/uit knop. d 1T | | M
2. Het welkomstscherm verschijnt } )
wanneer u het apparaat voor de "
eerste keer inschakelt of nadat u een

Aan/uit knop

hardwarematige reset hebt uitgevoerd.
Tik op een willekeurige plaats op het
scherm om door te gaan.

OPMERKING Raadpleeg de N
beschrijving op pagina 4
om een hardwarematige
reset uit te voeren.

3. Tik op het midden van het kruis om het
scherm uit te lijnen. U zult deze stap
mogelijke meerdere keren moeten
uitvoeren voor een correcte kalibratie.

OPMERKING U kunt de functie Scherm
uitlijnen (Align Screen) op
elk ogenblik uitvoeren door
te tikken op I > Instellingen
(Settings) > tabblad Systeem
(System) > pictogram Scherm
(Screen) > Knop Scherm
uitlijnen (Align Screen).

4. Volg de opeenvolgende instructies op het scherm.

5. Tik op een willekeurige plaats op het scherm Voltooid (Complete)
wanneer u klaar bent met de uitlijning en instellingen.
U bent nu klaar om uw apparaat te gebruiken.
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Basisschermen op MyPal
Het scherm Vandaag (Today)

Het scherm Vandaag (Today) zal normaal telkens worden weergegeven
wanneer u het apparaat elke dag voor de eerste keer inschakelt.

OPMERKING Wanneer het apparaat al is ingeschakeld en het scherm
een ander programma toont, kunt u op elk ogenblik
terugkeren naar het scherm Vandaag (Today) door te
tikken op EHl > Vandaag (Today).

Zoals weergegeven in het onderstaande voorbeeld, biedt het scherm
Vandaag (Today) u in één oogopslag een overzicht van de belangrijke
informatie van de dag.

Tik om de netwerk- of modeminstellingen in te stellen of te wijzigen
Tik om het volume te regelen of alle geluiden te dempen
Tik om het menu ; Tik om het batterijniveau weer te geven

#4 Start

Start te openen
en te kiezen uit
de beschikbare

programma’s

Tik om de datum en tijd te wijzigen

Uw dag in één oogopslag

Tik om de weergave te schakelen tussen de
liggende en staande stand.

Tik om het menu ASUS Status te openen. In
dit menu kunt u de standaard apparaatstatus
en de instellingen bekijken. (instelling
achtergrondverlichting, batterijniveau,
geheugengebruik en meer)

Tik om het Bluetooth®menu weer te geven
Tik om het WiFi®-menu weer te geven

Tik om het programma Agenda Tik om het programma
(Calendar) te openen Contactpersonen
(Contacts) te openen

Tik met de pen in het scherm Vandaag (Today) op een van de
weergegeven items om de details weer te geven. Zie “Hoofdstuk 2:
Basisbewerkingen” voor meer informatie over de manier waarop u huidige
taken of activiteiten kunt wijzigen of nieuwe items of informatie kunt
toevoegen.
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Het menu Start

Via het menu Start o vardaag
m Tl S bades

kunt u programma’s, B Agenda

instellingen en i Berichten raritn Tik om een programma te openen
help-onderwerpen [ mwu—_—
selecteren. Tik op het || E*T
pictogram Ed bovenaan : :,::::M e Tik om een recent gebruikt
in het scherm om het  [CREEEESS programma te openen

M Afbeeldingen en vicss5 Tik het P )
menu Start weer te p— _‘-‘ T om et ey Programmts
geven. B Instellingen | ey Tik om het menu Instellingen

3 5 (Settings) te openen
il I LA Tik om de Help-onderwerpen weer
te geven

Rgenda Contacten

De menubalk

De menubalk bevindt zich onderaan op het scherm van een programma. U
kunt de menu’s en knoppen op de menubalk gebruiken om opdrachten en

acties uit te voeren.

De menu’s en knoppen verschillen afhankelijk van de programma’s die u
gebruikt.

Pop-upmenu’s
Met de pop-upmenu’s
kunt u heel eenvoudig
een actie voor een

item selecteren. U ¥

Epicien

d Maam wijrigen
Wermpderen Tik op de actie die u wilt
E uitvoeren

o .'rn-mul:n_
kunt bijvoorbeeld o [
het pop-upmenu van mﬂmnz_f Tik en houd de pen tot het
de Verkenner (F||e = VidyafcroenO.  26-T07 22mK pop-upmenu verschijnt

Explorer) gebruiken om | S oo 2

een item te verwijderen, |=weyascreens. vy zesc

te kopiéren of uit te Rt AT A Tik buiten het pop-upmenu
I om het te sluiten zonder
zenden. een actie uit te voeren

Dmboog [=] “ena

Om een pop-upmenu te openen, tikt en houdt u de pen op het item dat
waarvoor u de actie wilt uitvoeren. Wanneer het menu verschijnt, tilt u
de pen op en tikt u op de actie die u wilt uitvoeren. Om het pop-upmenu
te sluiten zonder een actie uit te voeren, tikt u op een willekeurige plaats
buiten het menu.

OPMERKING De pop-upmenu’s zijn ook beschikbaar in de meeste
andere programma’s op uw apparaat. De items van
deze pop-upmenu’s kunnen echter variéren afhankelijk
van het programma of de toepassing.

Hoofdstuk 1



Hoofdstuk 2 Basisbewerkingen

De systeeminformatie weergeven [E°

Met uw apparaat kunt u de ingebouwde specificaties gemakkelijk
weergeven.

OPMERKING De gegevens die op de schermen met
systeeminformatie worden weergegeven, kunnen niet
worden gewijzigd.

De systeeminformatie weergeven:

1. Tik op Ed > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Systeeminformatie (System Information)

2. Tik op het tabblad Apparaatinformatie (Device Info) om de
specificaties van het apparaat weer te geven. Hiermee worden
verschillende gegevens weergegeven, zoals de apparaat-ID, het
systeemgeheugen en de draadloze capaciteiten.

3. Tik op het tabblad Versie (Version) om andere informatie over het
apparaat weer te geven.

Informatie invoeren

U kunt op een van de volgende manieren informatie invoeren op uw

apparaat:
+  Gebruik het invoerpaneel om tekst in te voeren met het
softwaretoetsenbord

+ Schrijf rechtstreeks op het scherm met de pen

+ Maak tekeningen op het scherm

+ Spreek in de microfoon van het apparaat om een bericht op te nemen

+  Gebruik Microsoft® ActiveSync® om de gegevens van uw
desktopcomputer te synchroniseren naar uw apparaat

Tekst invoeren via het invoerpaneel

Gebruik het invoerpaneel om informatie in elk programma van uw
apparaat in te voeren. U kunt typen met het softwaretoetsenbord. In elk
van deze gevallen verschijnen de tekens als getypte tekst op het scherm.

Tik op om het invoerpaneel weer te geven of te verbergen. Tik op
om de invoeropties weer te geven.

OPMERKING verschijnt alleen naast wanneer het invoerpaneel
niet verborgen is.

Basisbewerkingen 1
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Typen met het
softwaretoetsenbord:

v

m11|2|3|4]5]E[T[E|E|U|f[ﬂ]¢
1]

1. Tikop - > Toetsenbord
(Keyboard).

. - _— = | o
2. Tik met de pen op de toetsen op ::r'th m—— T IJI-

het toetsenbord op het scherm om
informatie in te voeren. m
Tik om het invoerpaneel weer te
geven of te verbergen Selecteer een

Tik om de opties voorde ~ Invoermethode
invoermethode weer te geven

Functie Woordaanvulling (Word completion)

Wanneer u het invoerpaneel en het softwaretoetsenbord gebruikt, zal uw
apparaat het woord dat u typt anticiperen en het boven het invoerpaneel
weergeven. Wanneer u op het weergegeven woord tikt, wordt dit in uw
tekst ingevoegd op het invoegpunt. Hoe meer u uw apparaat gebruikt, hoe
meer woorden het zal kunnen anticiperen.

De opties voor de functie o - (L]

[ -
Woordaanvulling wijzigen: L B
1. Tik op E > Instellingen (Settings) i

> tabblad Persoonlijk (Personal) H
> Invoer (Input) > tabblad
Woordaanvulling (Word Completion).
2. Breng de gewenste wijzigingen aan en  ———frem=t] -
. l1[z[3]4]5[6|7[a[a]o]/ [ale
tik op ok. Tab[a[wle[r [ty u]i]alp -
capla[s [d]f[gh]ji[k]I]+
Shilt |z |% | |¥ b [n[(m)], =t
s [<]]] HItI |-+
HNieLw gy = Mena

Tik hier als dit het woord is dat u wenst te gebruiken

Getypte tekst bewerken:

1. Selecteer de tekst die u wilt bewerken en gebruik een van de volgende
methoden:

. sleep de pen over de tekst
. tik tweemaal om een woord te selecteren
. tik driemaal om een alinea te selecteren

2. Tik in de menubalk op Menu en selecteer een actie of gebruik een van
de hulpmiddelen in het invoerpaneel om een nieuwe tekst in te voeren.

Hoofdstuk 2



Schrijven op het scherm

In elk programma dat handschrift
ondersteunt, zoals het programma Notities
(Notes) en op het tabblad Notities (Notes)

in Agenda (Calendar), Contactpersonen
(Contacts) en Taken (Tasks), kunt u de pen S
gebruiken om rechtstreeks op het scherm

te schrijven. Schrijf op de manier zoals u op
papier schrijft.

PE

Op het scherm schrijven:

1. Tik op Ed > Programma’s (Programs)
> Notities (Notes) > Nieuw (New)

2. Het scherm geeft een lege ruimte bij met
lijnen die u helpen bij het schrijven.

3. Schrijf uw tekst.

4]

OPMERKING Sommige programma’s die handschrift ondersteunen,
zullen mogelijk de knop Pen niet hebben. Raadpleeg de
documentatie voor dat programma om uit te vinden
hoe u naar de schrijfmodus kunt schakelen.

Uw handschrift bewerken:

1. Als u per ongeluk op het scherm schrijft, tikt u op Menu > Inkt
ongedaan maken om de laatste geschreven gegevens te verwijderen.

2. Om een tekst te selecteren, tikt u op Menu > Tekenen om van de
schrijfmodus naar de voorbeeldmodus te schakelen. Sleep de pen over
de tekst die u wilt selecteren.

3. Tik in de menubalk op Menu en
selecteer een actie of gebruik een van de
hulpmiddelen in het invoerpaneel om een
nieuwe tekst in te voeren.

Een zoomniveau selecteren:

+ Tik op Menu > In/uitzoomen. Tik op een
zoompercentage in de lijst.

Datum invoegen:

+ Tik en houd de pen op het scherm tot
het invoegpunt verschijnt en tik in het
snelmenu op Datum invoegen.

4]

NipLw i Meny

Basisbewerkingen
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Tekenen op het scherm

U kunt op dezelfde manier tekenen op het scherm zoals u op het scherm
schrijft. Het verschil tussen het schrijven en tekenen op het scherm ligt
in de manier waarop u items selecteert en de manier waarop ze kunnen
worden bewerkt. De grootte van tekeningen kan bijvoorbeeld worden
aangepast, terwijl dat niet mogelijk is met handschrift.

Een tekening maken:

1.

Gebruik de pen om een pennenstreek te maken die zich over drie lijnen
op het scherm uitstrekt. Een tekenvak verschijnt rond de pennenstreek.

OPMERKING Als de tekening geen drie lijnen doorkruist, wordt het
tekenvak niet weergegeven.

Blijf tekenen. Als uw opeenvolgende
pennenstreken buiten het vak reiken,
zult u merken dat het tekenvak wordt
vergroot zodat alle pennenstreken
binnen het vak vallen.

Het tekenvak geeft de randen
van de tekening aan

OPMERKING Om gemakkelijk te werken ./
aan uw tekening of deze
gemakkelijk weer
te geven, kunt u het
zoomniveau wijzigen door
te tikken op Menu > Mieuw i Menu
In/uitzoomen en
vervolgens de gewenste
zoominstelling te
selecteren.

4]

Uw tekening bewerken:

1.

2.

Tik en houd de pen op de tekening tot de selectiehandgreep verschijnt.
Als u meerdere tekeningen wilt selecteren, sleept u met de pen om de
gewenste tekeningen te selecteren.

Tik en houd de pen op de geselecteerde tekening en tik vervolgens op
een bewerkingsopdracht in het pop-upmenu of tik op een opdracht in
het Menu.

Pas de grootte van de tekening aan door een selectiehandgreep te
slepen naar de gewenste grootte.

Hoofdstuk 2



Een bericht opnemen

In elke programma waarin u op het scherm kunt schrijven of tekenen,
kunt u ook snel gedachten, herinneringen en telefoonnummers noteren
door een bericht op te nemen. In Agenda (Calendar), Taken (Tasks)

en Contactpersonen (Contacts), kunt u een opname in het tabblad
Notities (Notes) opnemen. In het programma Notities (Notes) kunt u een
onafhankelijke opname maken of een opname in een geschreven notitie
opnemen. Als u de opname in een notitie wilt opnemen, moet u de notitie
eerst openen. In het programma Postvak IN (Inbox) kunt u een opname
toevoegen aan een e-mailbericht.

Een opname maken:

1. Tik op B> Programma’s (Programs) > Notities (Notes) > Menu >
Opnamewerkbalk weergeven (View Recording Toolbar)

2. Houd de microfoon van uw apparaat dichtbij uw mond of een andere
geluidsbron.

3. Tikop ® (rode knop) om de opname te starten. Tk op ® om
de opname te stoppen. Wanneer u de opname stopt, hoort u twee
pieptonen.

4. De nieuwe opname verschijnt in de lijst Notes (Notities) of als
een ingesloten pictogram. Om de opname af te spelen tikt u op
de gewenste opname in de lijst. Als de opname in een notitie is
ingesloten, tikt u op het pictogram Luidspreker.

o W 840 ok

)

Het pictogram Luidspreker geeft
een ingesloten opname aan

Tik om de opname te starten

| 1 Tik om de opname te stoppen
=

o[u) [ w4

Mieuw — Menu

Basisbewerkingen
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De opname-indeling wijzigen:

1. Tik in de notitielijst op Menu > Opties (Options) > de koppeling
Algemene invoeropties > tabblad Opties (Options).

2. Selecteer de gewenste opname-indeling in het vervolgkeuzemenu
Spraakopname-indeling (Voice recording format) en tik vervolgens
op ok wanneer u klaar bent.

OPMERKING In vergelijking met andere instellingen biedt de Pulse
Code Modulation (PCM) een iets betere
geluidskwaliteit, maar neemt tot 50 maal meer
opslagruimte in beslag dan Mobile Voice-opnamen.

Informatie zoeken en organiseren

De functies Zoeken (Search) en Help op uw apparaat helpen u snel
informatie te vinden.

De functie Zoeken gebruiken

Informatie zoeken: Typ een woord dat u wilt zoeken
1. Tik op E > Help > Zoeken (Search). i ek A
2. Voer de tekst in die u wilt zoeken, Tnaknasrt rot -
selecteer een gegevenstype en tik Type: Al gegevers =
vervolgens op Zoeken (Search) om Resultaten
de zoekopdracht te starten. Selecteer e ]
Groter dan 64 KB (Larger than 64 Lﬁ"ﬂ st o b
KB) onder Type om snel informatie te Rt = —]
zoeken die veel ruimte inneemt op uw | =2 & 70 _SAE
apparaat_ Heslp 20:207 427ER  jm
Motites. schrgven
Halp a0 40 EB
- H H . E —
De Help-functie gebruiken: ﬂtﬂw ot e |8
1. Tik op Ed > Help. -
2. Tik op een koppeling naar het M
. Tik om het woord te zoeken
onderwerp dat u wilt weergeven. Gevonden onderwerpen

die het gezochte woord
bevatten

De Verkenner gebruiken -

De bestandsverkenner gebruiken om bestanden te zoeken en
te ordenen:

«  Tik op > Programma’s (Programs) > het pictogram Verkenner
(File Explorer) om de bestanden in uw apparaat weer te geven.
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Uw apparaat aanpassen

U kunt uw apparaat aanpassen door de instellingen te wijzigen, de
ingebouwde programma’s te gebruiken en extra software te installeren.

De beschikbare opties weergeven:

«  Tik op Bl > Instellingen (Settings) > tabblad Persoonlijk (Personal)
of Systeem (System).

OPMERKING Tik en houd de pen op de schuifregelaar aan de
rechterzijde van het scherm om de andere
instellingspictogrammen weer te geven.

eSS L

] ¢ . =

@A @ : A BFF 8

Geluiden en Indfo over Inwneer ASLIS- Ao Certificaten

meldingen  eigensar boest and

A T 4 B & W

E e Menid’s Vandasg Codering Ewternal  Foutrappo..
[r

d_zi"‘ % 'z i AR

Vergrend... Wekkerin. Geheugen Info Elantenle...
- g

— 0 — — o —
De datum en tijd wijzigen (

De datum- en tijdsinstellingen wijzigen:

1. Tik op B > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Klok en alarmsignalen (Clock & Alarms).

2. Kies de gewenste instellingen op het tabblad Tijd (Time).

OPMERKING Tik op het tabblad Meer (More) en selecteer De klok
in de titelbalk van alle programma’s weergeven
(Display the clock in the title bar in all programs)
om de klok op elk ogenblik weer te geven in de
rechterbovenhoek van het scherm.

De alarminstellingen wijzigen:

1. Tik op B> Instellingen (Settings) > tabblad Systeem (System)
> pictogram Klok en alarmsignalen (Clock & Alarms) > tabblad
Alarmen.

2. Kies de gewenste instellingen.

Basisbewerkingen



Het menu Start wijzigen ™

De menu-items wijzigen:

1. Tik op E > Instellingen (Settings) > QTR SN

Femni's
Menu’s.
. L. asslacteerds bems worden weengegEven n
2. Schakel het selectievakje in naast de DAk S A AP R o

lErgegEven in Progr smesa’s,

items die u wilt weergeven in het menu
Start. %:dﬂne&:h'-xﬂen videa's
3. Tik op ok. [Pl Berichten K|

[Flgdcontacten
)i Gedeside ntemnatverbinding
OPMERKING ltems die niet aan het [FigHe0

menu Start zijn (18} Irternet Explorer

toegevoegd, kunt u %ﬁw 1
terugvinden in de = - S x

programma’s — o

De gegevens van de eigenaar wijzigen 2
De gegevens van de eigenaar wijzigen:

1. Tik op E > Instellingen (Settings) >
pictogram Info over eigenaar (Owner
information). m I.In info

2. Typ de gegevens die u wilt weergeven
op het scherm Vandaag (Today).

3. Voeg notities toe aan de +886 2 67554321
eigenaarsgegevens door op het tabblad | #een-cybass.com
Notities (Notes) te tikken.

4. Typ de gewenste tekst in.

5. Tik op het tabblad Opties (Options)
en selecteer vervolgens de items die u
op het scherm wilt weergeven wanneer

u het apparaat inschakelt. Tik op ok
wanneer u klaar bent.

]

Inlo over elgenass 5 o5 o4

Een wachtwoord instellen /
Een wachtwoord instellen voor uw apparaat:

1. Tik op B > Instellingen (Settings) > pictogram Vergrendeling (Lock).

2 Schakel het selectievakje Vragen indien apparaat niet gebruikt
wordt (Prompt if device unused) in en selecteer vervolgens de
periode in de beschikbare opties door op de pijl omlaag te tikken.

3. Selecteer het wachtwoordtype als Eenvoudig vier CIJFERS (Simple
4 digit) of Sterk alfanumeriek (Strong alphanumeric).
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4. Typ een wachtwoord. Als u het type Sterk alfanumeriek hebt
geselecteerd, moet u het wachtwoord tweemaal invoeren.

5. Tik op het tabblad Geheugensteun (Hint) om een soort herinnering te
maken voor het geval u uw wachtwoord vergeet.

6. Tik op ok wanneer u klaar bent.

De stand van de schermweergave wijzigen 3
De stand van de schermweergave wijzigen:
1. Tik op E > Instellingen (Settings) > tabblad Systeem (System) >

pictogram Scherm (Screen).

2. Selecteer de gewenste stand en tik op ok.

Staand

s  Instellingen

Scherm

 Aldrukst
Stasnd
Liggend

Scherm uitlignen
Ligry ekt e it s et risk goed
reagecrt op de aanraking van de #ift,

[ Dfice Mobile

B Agenda

& Berithten

[ Contacten

/7 Intermet Explorer
P rotities

B raken

G Windows Media
. Yerkenner

a Allseebihiisgen en vedea's
& Programma’s '

=
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De ClearType-functie inschakelen:

1. Tik op B> Instellingen (Settings) > tabblad Systeem (System) >
pictogram Scherm (Screen) > tabblad Clear Type.

2. Schakel het selectievakje Clear Type inschakelen (Enable Clear
Type) in en tik op ok.

De tekstgrootte op het scherm wijzigen:

1. Tik op Ed > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Scherm (Screen) > tabblad Tekengrootte (Text Size).

2. Verplaats de schuifregelaar naar Extra Klein (Smallest) of Extra Groot
(Largest) tot u de gewenste tekstgrootte verkrijgt. Tik op ok.

OPMERKING De schuifregelaar wordt Basis in het midden geplaatst.

Het schermthema wijzigen

Het schermthema wijzigen:
1. Tik op Ed > Instellingen (Settings) > pictogram Vandaag (Today).
2. Selecteer het gewenste thema in de beschikbare opties,

of

Schakel het selectievakje Deze afbeelding als achtergrond
gebruiken (Use this picture as the background) en tik op
Bladeren (Browse) om een afbeelding te selecteren uit uw
afbeeldingsbestanden.

3. Tik op ok wanneer u klaar bent.

De items die op het scherm Vandaag (Today) moeten
verschijnen, definiéren:

1. Tik op E > Instellingen (Settings) > pictogram Vandaag (Today) >
tabblad Items.

2. Schakel de selectievakjes naast de gewenste items in. Tik op ok
wanneer u klaar bent.

De knoptoewijzingen wijzigen !

De knoptoewijzingen wijzigen:

1. Tik op B > Instellingen (Settings) > pictogram Knoppen (Buttons).
2. Markeer een knop door erop te tikken.

3. Tik op de pijl omlaag om de programma’s waaraan u de knop kunt
toewijzen, weer te geven.

4. Herhaal stappen 2 tot 3 om andere knoptoewijzingen te wijzigen.
5. Tik op ok wanneer u klaar bent.
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De knopinstellingen aanpassen:

1. Tik op het tabblad Bedieningselement omhoog/omlaag (Up/Down
Control).

2. Tik op de schuifregelaar en sleep deze naar de gewenste instellingen
voor de responstijd van de knop Omhoog/Omlaag.

3. Tik op het tabblad Geavanceerd (Advance) om de opties voor de
toetsverlichting en de vergrendelingsknop in te stellen.

4. Tik op ok wanneer u klaar bent.

De schakelknop Modus en de schakelknop
Taken gebruiken ©»

De rechterknop van de groep knoppen uiterst rechts op het apparaat
(zie Hoofdstuk 1) werkt Basis als de knop voor het schakelen tussen
modi, zodat u snel kunt schakelen tussen het scherm Vandaag (Today),
Windows Media Player en het scherm Draaien (Rotate). Wanneer u op
deze knop drukt, verschijnt het venster MODUS omschakelen (Mode
Switcher) op het scherm.

De MODUS omschakelen aanpassen:

1. Tik op E > Instellingen (Settings) > tabblad Systeem (System)
> MODUS omschakelen (Mode Switcher) > tabblad MODUS
omschakelen (Mode Switcher).

2. De drie programma’s die eerder werden vermeld, worden Basis
geselecteerd om in het venster MODUS omschakelen (Mode Switcher)
te worden weergegeven. U kunt een programma verwijderen door het
overeenkomstige selectievakije uit te schakelen.

3. Tik op de knop 447 of ¥kl om de volgorde van de programma’s te wijzigen.

4. Schakel het selectievakje onder a."I‘( in als u een pictogram Afsluiten
(SExit) r\]/vilt) toevoegen aan het venster MODUS omschakelen (Mode
witcher).

5. Tik op ok wanneer u klaar bent.
Als u de knoptoewijzing wilt wijzigen zodat het een knop van de Taken
omschakelen (Task Switcher) wordt, volgt u de onderstaande stappen. Met

de Taken omschakelen kunt u schakelen tussen de momenteel geopende
programma’s.

De Taken omschakelen inschakelen:

1. Tik op B > Instellingen (Settings) > tabblad Systeem (System) >
MODUS omschakelen (Mode Switcher) > tabblad Basis (Basic) en
selecteer vervolgens Taken omschakelen (Task Switcher).

2. Tik op ok.

OPMERKING Op het tabblad Basis (Basic) kunt u de uitgestelde
tijd voor de weergave van het venster MODUS
omschakelen (Mode Switcher) of Taken omschakelen
(Task Switcher) verhogen zodat u meer tijd hebt om
selecties te maken.
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De Verlichting instellen [

De Verlichting instellen:

1.

2.

Tik op EH > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Verlichting (Backlight).

Pas de helderheid van het scherm aan door de schuifregelaar naar
Donker (Dark) of Helder (Bright) te slepen tot u de gewenste
helderheid van het scherm hebt bereikt.

Tik op het tabblad Geavanceerd (Advance) en pas de instellingen aan
voor Verlichting wanneer u batterijvermogen en wisselstroom gebruikt.

. Tik op ok wanneer u klaar bent.

De instellingen voor het batterijvermogen
wijzigen &
De instellingen voor het batterijvermogen wijzigen:

1.

4.

Tik op E > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Voeding (Power) om de status van het batterijvermogen
weer te geven. Dit scherm toont de gedetecteerde percentages van
het resterende batterijvermogen. U mag de informatie op dit scherm
niet wijzigen.

Tik op het tabblad Geavanceerd (Advanced) om de instelling voor de
batterij aan te passen zodat u energie kunt sparen.

Tik op het tabblad Actieve-modus (CPU Mode) om het
verwerkingsvermogen in te stellen dat moet worden gebruikt wanneer
programma’s worden gebruikt.

#= Maximum biedt een betere CPU-prestatie. Stel deze modus in
wanneer u spelletjes speelt of video’s afspeelt. Als u de Turbomodus
instelt, kan dit echter de levensduur van de batterij verkorten.

#= Normaal (Normal) biedt een normale CPU-snelheid en een
meer stabiele prestatie. Selecteer deze modus wanneer u MP3-
geluidsbestanden beluistert of toepassingen gebruikt die geen zeer
hoge CPU-snelheid vereisen.

% Energie besparen (Power Save) stelt de CPU in op een lagere
snelheid. Deze modus heeft een lagere CPU-prestatie, maar verlengt
de levensduur van de batterij. Selecteer deze modus wanneer u op
tekst gebaseerde toepassingen, zoals Word, Excel, enz. gebruikt.
Als u de energiebesparing automatisch wilt instellen, tikt u in de cirkel
Naast # Auto. Deze modus past de CPU-snelheid aan volgens het
programma waarmee u werkt.

Tik op ok wanneer u klaar bent.

Hoofdstuk 2



Geluiden en meldingen selecteren @

Uw apparaat kan u op verschillende manieren herinneren aan zaken die

u moet doen. Als u bijvoorbeeld een afspraak in Agenda (Calendar) hebt
ingesteld, een taak met een vervaldatum of een alarm in Klok (Clock),
wordt u hiervan op een van de volgende manieren op de hoogte gebracht.
+ Een berichtenvenster wordt op het scherm weergegeven

+ Een geluid wordt afgespeeld (u kunt het type geluid selecteren)

+ Een lampje knippert op het apparaat

Geluiden en meldingen instellen:

1. Tik op E > Instellingen (Settings) > tabblad Persoonlijk (Personal)
> pictogram Geluiden en meldingen (Sounds & Notifications) >
tabblad Geluiden (Sounds) en selecteer vervolgens de items die u wilt
inschakelen.

2. Tik op het tabblad Meldingen (Notifications) en stel de details in voor
de melding van de gebeurtenis.

3. Tik op ok wanneer u klaar bent.
De geluidsinstellingen wijzigen [

De geluidsinstellingen wijzigen:
1. Tik op E > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Audio.

2. Pas het volume, de balans, de hoge tonen, de lage tonen en de 3D-
instellingen aan door de schuifregelaar naar links of naar rechts te
slepen tot u de gewenste geluidsuitvoer hebt verkregen.

3. Tik op ok wanneer u klaar bent.

OPMERKING Tik op de knop Basis (Default) om de Basis
geluidsinstellingen te herstellen.

De microfooninstellingen wijzigen:
1. Tik in het scherm voor de geluidsinstellingen op het tabblad Mic.

2. In Bedieningselement microfoonversterking (MIC Gain Control) kunt u
ervoor kiezen om de versterking handmatig aan te passen of om het
apparaat automatisch het opnamevolume te laten aanpassen. Stel
het volume hoger of lager in door de schuifregelaar naar links of naar
rechts te slepen.

OPMERKING Tik op Basis (Default) om terug te keren naar de
Basisinstellingen.

Basisbewerkingen



De Weekerinstellingen wijzigen R
1. Tik op B > Instellingen (Settings) > tabblad Persoonlijk (Personal)
> pictogram Weekerinstellingen (Wakeup Source).

2. Schakel de selectievakjes van de items in om te bepalen welke
functies/omstandigheden de voeding van het apparaat zullen
inschakelen. Wanneer u op een van de functieknoppen op het
voorpaneel drukt, wordt het apparaat geactiveerd.

3. Tik op ok wanneer u klaar bent.

De USB-instellingen wijzigen ;=
De USB-instellingen wijzigen

1. Tik op E > Instellingen (Settings) > tabblad Verbindingen
(Connections) > pictogram USB-instelling (USB Settings).

2. Kies een USB-interface.

ActiveSync (hoge snelheid) - hiermee is een seriéle verbinding
met hoge snelheid mogelijk tussen uw apparaat en uw pc.
Selecteer dit wanneer u ActiveSync gebruikt.

ActiveSync (lage snelheid) - hiermee is een seriéle verbinding
met lage snelheid mogelijk tussen uw apparaat en uw pc. Selecteer
dit wanneer u ActiveSync gebruikt.

Massaopslagapparaat (kaartlezer) - verandert uw apparaat in
een massa opslag eenheid zoals een kaartlezer.

3. Tik op ok wanneer u klaar bent.
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De geheugeninstellingen wijzigen &

De geheugentoewijzing weergeven:

1. Tik op E > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Geheugen (Memory).

2. Tik op ok wanneer u klaar bent.

Het geheugen van de opslagkaart controleren:

1. Tik op B > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Geheugen (Memory) > tabblad Opslagkaart (Storage
Card) om de geheugeninformatie voor de geselecteerde opslagkaart
weer te geven.

2. Als u geheugen wilt vrijmaken op de geheugenkaart, moet u
enkele bestanden van de geheugenkaart verwijderen. Gebruik
de Bestandsverkenner om de bestanden te verwijderen. Zie “De
Bestandsverkenner gebruiken” voor meer informatie.

Actieve programma’s weergeven:

1. Tik op B > Instellingen (Settings) > tabblad Systeem (System) >
pictogram Geheugen (Memory) > tabblad Actieve programma’s
(Running Programs).

2. Als u systeemgeheugen dat momenteel door de actieve programma’s

wordt gebruikt, wilt vrijmaken, selecteert u een programma en tikt u
vervolgens op Stoppen.

Om alle actieve programma’s te stoppen, tikt u op Alle stoppen (Stop
All).

Eenvoudige toepassingen gebruiken

Uw apparaat bevat meerdere eenvoudige
toepassingen die nuttig zijn voor uw

dagelijks gebruik van uw apparaat.
OPMERKING De belangrijkste

toepassingen die bij
Microsoft® Windows
Mobile® 6 zijn geleverd, | ™"~ =
worden in andere & -i
hoofdstukken besproken. Presentatory sed  Taken

De toepassingen openen: 3! £

Werkenner Wiy a Windows i:
1. Tik op El > Programma’s (Programs). _‘“‘:&

2. Tik op een pictogram om een specifieke
toepassing te starten.

Basisbewerkingen
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Rekenmachine

Tik op het pictogram Rekenmachine (Calculator) om de basisfuncties
van de rekenmachine te gebruiken.

Spelletjes =
Tik op het pictogram Spellen (Games) om de beschikbare spelletjes
weer te geven.

@
Bubble Breaker @@

Het hoofddoel van dit spel is alle luchtbellen te doen barsten. Tik hiervoor
op twee of meer toverballen van dezelfde kleur die met elkaar verbonden
zijn. Hoe meer bellen u tegelijk laat barsten, hoe hoger uw score.

Solitaire *.

Het hoofddoel van dit spel is alle kaarten van het spel te gebruiken om vier
stapels met hetzelfde teken te vormen in oplopende volgorde, te beginnen
met de azen.

OPMERKING Raadpleeg de Help-informatie op uw apparaat door te
tikken op I > Help > Inhoud (Contents) > Spellen
spleen (Play Games) voor meer details over de spelregels.

Afbeeldingen en video’s *

Gebruik Afbeeldingen en video’s (Pictures & Videos) voor het
weergeven van foto’s en het afspelen van video’s die in verschillende
indelingen op uw apparaat of uw opslagkaart zijn opgeslagen. U kunt ze
vervolgens verzenden naar uw vrienden, een diavoorstelling van uw foto’s
weergeven, de video afspelen of een foto als achtergrond instellen voor
het scherm Vandaag (Today).

Raadpleeg ook de on line help van uw apparaat voor meer informatie over
het gebruik van deze functie.

Foto’s gebruiken:

1. Tik op B> Programma’s (Programs) > pictogram Afbeeldingen en
video’s (Pictures & Videos).

2. Tik op de miniatuurafbeelding van de foto of video die u wilt openen.

3. Tik op Menu wanneer de foto of video op het scherm verschijnt om te
zoomen (inzoomen, uitzoomen of aanpassen aan het venster), een
diavoorstelling af te spelen, uw foto te bewerken of de video af te
spelen.
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4. Tik op Menu > Instellen als achtergrond... (Set as Today
Background...) om de foto als achtergrond voor het scherm Vandaag
(Today) te gebruiken.
of

Tik op Menu > Foto verzenden (Beam picture...) als u de foto via de
IR-poort wilt verzenden naar een ander apparaat.

5. Tik in de menubalk op Verzenden (Send) om de foto te verzenden als
bijlage bij een e-mail.

De automatische correctie gebruiken:

+ Tik op Menu > Bewerken (Edit) > Menu > Autocorrectie (Auto
Correct) om de foto automatisch aan te passen.

OPMERKING Tik op Menu > Ongedaan maken (Undo) om de laatste
actie ongedaan te maken. Tik op Terug naar opgeslagen
(Revert to Saved) om alle acties die op de foto werden
uitgevoerd ongedaan te maken.

De foto draaien:

+ Tik in de menubalk op Menu > Bewerken (Edit) > Draaien (Rotate).
Telkens wanneer u tikt op Draaien (Rotate) wordt de foto 90° rechtsom
gedraaid.

De foto bijsnijden: i Albeclingen en vill = 42

Tik in bt wake orm bij be snijden

1. Tik op Menu > Bewerken (Edit) > Menu
> Bijsnijden (Crop).

2. Sleep de pen over het scherm
om het gedeelte van de foto dat
wilt behouden, te selecteren.

3. Tik binnen het bijsnijdvenster om de foto
bij te snijden.

4. Tik op Ongedaan maken (Undo) om de
laatste actie ongedaan te maken.

De foto opslaan:

+ Tik op Menu > Opslaan als (Save As) om de wijzigingen op te slaan
nadat u de foto hebt bewerkt.
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De apparaatstatus controleren A

Gebruik de ASUS-toestand om snel essentiéle apparaatgegevens zoals
het gebruik van de opslagruimte en de levensduur van de batterij weer te
geven.

ASUS-toestand openen:

se  Gtart

1. Tik op het pictogram ASUS-toestand in de  [irEs

rechterbenedenhoek van het scherm.

2. Een menu wordt geopend met algemene
informatie over uw apparaat. Tik op een e —
item om meer opties voor dat specifieke ";‘-’: :"* bl
. et CPLE: Aufo
item te openen. B verkhting: 100N

@ Battery: Voodng

B Progaming £5.448

@ Dpslag: 173508

o colautiRgo) 120,

LELDTH 43 inatolng..

De instellingen voor ASUS-toestand wijzigen:

1. Tik op het pictogram ASUS-toestand 55 AGUS toestand o2 ¢ 007 ok |

in de rechterbenedenhoek van het Tw, et pictogeam van schesmyntatie
scher_m en tik daarna op Instellingen v FPCILISL DEAD0 e HO
(Setting...). [] Tocn toestand met ba: [ Rand

. . Ohjecten tonan

2. Maak de gewenste selecties uit de [ [ cpusrehed) @) Opeian

beschikbare items. U kunt items uit B[ verichting @8 Schkaart
het menu ASUS-toestand verwijderen |Heatters  ARAusa
door de selectievakjes naar het item in (@] Programma

Systeemtoestand (System status) uit
te schakelen.

3. Tik op ok om de wijzigingen aan te

brengen. —

OPMERKING Als u het selectievakje naast Toon het pictogram
van systeemtoestand (Show system status
icon) uitschakelt, het pictogram ASUS-toestand wordt
niet weergegeven op het scherm Vandaag (Today). Om
het pictogram ASUS-toestand opnieuw weer te geven,
tikt u op > Instellingen (Settings) > Tabblad Systeem
(System) > pictogram ASUS-toestand.
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Hoofdstuk 3
Synchroniseren en verbeteren

Microsoft® ActiveSync®

Microsoft® ActiveSync®is een van de belangrijke programma'’s die bij MyPal wordt
aangeboden. Met ActiveSync kunt u de informatie op uw computer synchroniseren
met de informatie op uw Pocket PC. Synchronisatie vergelijkt de gegevens op uw
Pocket PC met die van uw computer en werkt beide bij met de meest recente
informatie. De laatste versie van Microsoft® ActiveSync® kunt u downloaden van
de website: www.microsoft.com/windowsmobile/addons/default.mspx

Bijvoorbeeld:

+ Houd gegevens van Pocket Outlook up-to-date door uw Pocket PC
te synchroniseren met de gegevens van Microsoft Outlook op uw
computer.

+ Synchroniseer bestanden van Microsoft Word en Microsoft Excel
tussen uw apparaat en uw computer. Uw bestanden worden
automatisch naar het juiste formaat geconverteerd.

OPMERKING Standaard zal ActiveSync niet automatisch alle types
informatie synchroniseren. Gebruik de opties van
ActiveSync om de synchronisatie voor specifieke
informatietypes in of uit te schakelen.

Met ActiveSync, kunt u ook:

+ Bestanden kopiéren (in plaats van synchroniseren) tussen uw Pocket
PC en uw computer.

+ Bepalen wanneer de synchronisatie wordt uitgevoerd door een
synchronisatiemodus te selecteren. U kunt bijvoorbeeld doorlopend
synchroniseren terwijl uw Pocket PC is aangesloten op uw computer,
of alleen synchroniseren wanneer u dat zelf wilt.

+ Selecteren welke informatietypes worden gesynchroniseerd en
bepalen hoeveel gegevens worden gesynchroniseerd. U kunt
bijvoorbeeld kiezen om alleen uw afspraken van de laatste twee
weken te synchroniseren, zodat oudere afspraken niet worden
gesynchroniseerd.

Voor meer informatie over het gebruik van ActiveSync:

1. Start ActiveSync op uw computer.

2. Klik in de menubalk van Activesync op Help > Microsoft ActiveSync
Help.

Synchroniseren en verbeteren
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ActiveSync®installeren

Het programma ActiveSync is reeds geinstalleerd op uw Pocket PC. Om de
informatie op uw Pocket PC te synchroniseren met uw computer, moet u
ook ActiveSync op uw computer installeren. Installeer ActiveSync vanaf de
“Getting Started CD” (Cd Aan de slag) die in uw productverpakking is geleverd.

OPMERKING Voordat u de installatie van ActiveSync start, dient u
te controleren of Microsoft® Outlook® op uw computer
is geinstalleerd. Zelfs als Outlook 2000 is geinstalleerd
op uw computer, raden wij u aan een update uit te voeren
van de versie van Outlook die op de begeleidende cd is
meegeleverd.

ActiveSync op uw computer installeren:
1. Schakel uw computer en beeldscherm in.

BELANGRIJK Sluit uw Pocket PC niet aan op uw computer tot u de
installatie van ActiveSync hebt voltooid.

2. Plaats de “Getting Started CD” (Cd Aan de slag) in het optische station
van uw computer. De CD wordt automatisch uitgevoerd en geeft het
startscherm weer, gevolgd door het hoofdmenu waar u de installatie
kunt starten.

3. Lees het Overview (Overzicht) voordat u ActiveSync installeert zodat u
zeker bent dat u de installatievolgorde correct uitvoert.

4. Volg de instructies op de achtereenvolgende schermen.

Als u ActiveSync reeds op uw computer hebt geinstalleerd, zal de
installatiewizard dit detecteren en dit vermelden in een bericht.

Klik op Next (Volgende) om door te gaan met de installatie en de
huidige versie te vervangen.

Klik op Cancel (Annuleren) om af te sluiten en de huidige versie te
behouden.

5. Wacht tot de wizard klaar is met het kopiéren van alle benodigde
bestanden en uw systeem bijwerkt.

OPMERKING U kunt de Pocket PC direct na de installatie van
ActiveSync aansluiten op uw computer. Controleer of de
optie Verzenden als netwerkinterface (Transmission
as Network Interface) of Verzenden als seriéle interface
(Transmission as Serial Interface) is geselecteerd
onder Instellingen (Settings) > tabblad Verbindingen
(Connections) > USB-instellingen (USB Settings).
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Uw Pocket PC synchroniseren

Uw Pocket PC aansluiten op een computer

1. Sluit de 26-pins apparaatstekker van de synchronisatiekabel aan op de
26-pins aansluiting op de onderkant van uw apparaat.

2. Sluit het andere uiteinde van de synchronisatiekabel aan op de USB-
poort van uw computer.

Een synchronisatierelatie instellen

Meteen nadat u de installatie hebt voltooid, wordt de wizard Instelling
synchronisatie (Sync Setup) automatisch gestart om u te helpen
een synchronisatierelatie tot stand te brengen en uw synchronisatie-
instellingen aan te passen. Nu kunt u precies bepalen welke
informatietypes u wilt synchroniseren met uw computer.

Een sync relationship is een bestand dat u in staat stelt uw Pocket
PC met uw computer te synchroniseren. Dit bestand is opgeslagen
op uw computer. Een extra bestand, dat uw computer in staat stelt
uw apparaat te herkennen, is opgeslagen op uw Pocket PC.

Synchroniseren en verbeteren
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Een synchronisatierelatie instellen:

1.

Klik in het scherm Wizard
Synchronisatie-instelling
(Synchronization Setup Wizard)
op Volgende (Next).

Selecteer het type informatie
dat u wilt synchroniseren.
Klik op Next (Volgende). Als
u een gesynchroniseerd item
wilt aanpassen, selecteer dan
het item en klik op Settings
(Instellingen).

Selecteer bijvoorbeeld

in het venster Calendar
Synchronization Settings
(Synchronisatie van de
Agenda) de opties die bepalen
hoe u de afspraken op uw
apparaat wilt synchroniseren met
uw computer. Klik op OK.

Klik op Voltooien (Finish)
om de instelling voor de
synchronisatierelatie te voltooien.
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Onmiddellijk nadat u een
synchronisatierelatie hebt
ingesteld, wordt ActiveSync

automatisch gestart en wordt de
eerste synchronisatie tussen uw
apparaat en uw computer gestart.

Raadpleeg de volgende
secties voor meer details over
synchronisatie.

6F frpee i o Vecknnnes

[ty vasbasger 2

Gesynchroniseerde informatie controleren

Bekijk na uw eerste synchronisatie, de Calendar (Agenda), de Contacts
(Contactpersonen) en de Tasks (Taken) op uw Pocket PC. U zult merken
dat de agenda-informatie van Microsoft Outlook op uw computer naar uw
Pocket PC werd gekopieerd, en dat de informatie van uw Pocket PC naar

uw computer werd gekopieerd.

Wy o}

Synchronisenen

Gegmvanztype Sihe
Syncheoacmmn

i Windows PC
E_.::I Feworneten

@

Drelisdls veubeigen &

OPMERKING Open Microsoft Outlook op uw computer om details
weer te geven van de informatie die vanaf uw Pocket

PC werd gekopieerd.

Synchroniseren en verbeteren
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Synchronisatie handmatig starten

Wanneer u ActiveSync heeft ingesteld en het eerste synchronisatieproces
heeft voltooid, kunt u op elk ogenblik de synchronisatie starten vanaf uw
Pocket PC.

De synchronisatie handmatig starten:

1. Tik op B > Programs > ActiveSync om het scherm ActiveSync weer
te geven.

P Py P |
sy ActivESyTC tofmsT X

PL Windaws
Synchrondseren Fa Verbindingsstatus
[ |
Tik om de synchronisatie te Tik om de synchronisatie-
stoppent/te starten instellingen te wijzigen

2. Om de synchronisatie te starten, maakt u een verbinding tussen uw
Pocket PC en uw computer, en tikt u op Sync.
Om de synchronisatie te beéindigen, tikt u op Stop.

Om te synchroniseren via IR (infraroodpoort) of om de synchronisatie-

instellingen te wijzigen, moet u de synchronisatie met uw computer
stoppen.

OPMERKING Voor meer informatie over synchronisatie, tik op % |
terwijl u in het ActiveSync-scherm bent en tik
vervolgens op Help.
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Synchronisatie-opties

Met het programma Microsoft ActiveSync kunt u op elk gewenst moment
uw synchronisatie-instellingen aanpassen. U kunt de items selecteren die
u wilt synchroniseren, de synchronisatieplanning instellen en de regels
voor de synchronisatie definiéren.

De synchronisatie-opties weergeven:

+  Klik op uw computer in het venster ActiveSync op het pictogram
Option (Opties), of

+ Klik in de menubalk op Tools/Options (Extra/Opties).

De items selecteren die u wilt synchroniseren:

1. Schakel het selectievakje in naast het item dat u wilt synchroniseren.
2. Selecteer een aangekruist item en klik op Settings (Instellingen) om
de synchronisatie-opties voor het item te definiéren.
Selecteer bijvoorbeeld uw Calendar (Agenda) en klik vervolgens
op Settings (Instellingen) om het venster met de Calendar

Synchronization Settings (Synchronisatie van de Agenda) te openen.

Pas de beschikbare instellingen aan en klik op OK wanneer u klaar
bent.

3. Doe hetzelfde voor de andere aangekruiste items.

OPMERKING U kunt geen opties instellen voor items die niet zijn
aangekruist.

4. Klik op OK wanneer u klaar bent.

Synchroniseren en verbeteren
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Hoofdstuk 4
Microsoft® Pocket Outlook

Microsoft® Pocket Outlook bevat Agenda, Contacten, Taken, Notities en
Postvak IN. U kunt deze programma’s afzonderlijk of samen gebruiken.
U kunt bijvoorbeeld een e-mailadres, dat in de Contacten is opgeslagen,
gebruiken om e-mailberichten te adresseren in het Postvak.

Met ActiveSync®kunt u informatie van Microsoft Outlook of Microsoft
Exchange op uw computer synchroniseren met uw Pocket PC. U kunt
deze informatie ook rechtstreeks met een Microsoft Exchange server
synchroniseren. ledere keer wanneer u synchroniseert, zal ActiveSync de
wijzigingen vergelijken die u heeft aangebracht op uw Pocket PC en op
uw computer of server, en vervolgens beide computers bijwerken met de
nieuwste informatie. Voor informatie over het gebruik van ActiveSync, kunt
u het Helpbestand van ActiveSync op uw computer raadplegen.

U kunt schakelen naar een van de programma’s van Pocket Outlook door
te tikken op Ed.

Calendar (Agenda)

Gebruik de Calendar (Agenda) om afspraak, inclusief vergaderingen en andere
gebeurtenissen te plannen. U kunt de afspraak bekijken in verschillende
weergaven (agenda, dag, week, maand en jaar). U kunt gemakkelijk naar
een andere weergave schakelen via het menu View (Beeld).

27 jul 07 mdﬂﬁnn B il

N T 13 SIS 17
: - - Tik om afspraakdetails weer te
14:00- 1800 geven of te bewerken

Tik om de agenda weer te
geven per Dag, Week, Maand,
Jaar of Agenda

rm Tik om een nieuwe
m_ afspraak te maken
OPMERKING U kunt aanpassingen, zoals het wijzigen van de eerste

dag van de week, aanbrengen aan de agendaweergave
door te tikken op Menu > Opties (Options).

Microsoft® Pocket Outlook
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Afspraak maken

Een afspraak maken:

1. Als u zich in de dag- of weekweergave bevindt, tikt u op de gewenste
datum voor de afspraak,

2. Tik op Menu > Nieuwe afspraak (New Appointment).

Onderwanp: ™ 15— Tik om een vooraf gedefinieerde tekst te selecteren
Locatie: = Tik om eerder ingevoerde locaties
Bagint: 27-7407 12:00 te selecteren
Eindegt: 27-7-07 1300 —=— Tik om de tijd voor de afspraak te definiéren

Do hasle dag: Mg L Tik om de datum voor de afspraak te definiéren

Kot woor: Edn kiser =
Herirnerning: Hérinneér mij hieraan
15 riowt (minuten)

Ll

Cabagormin; il e,
Aifspr sk, | Notities — Tik om notities toe te voegen aan een afspraak
e 1]z[3]a]s]a[7[ala]o]/[a]e
Tab|g [wle|r ItIrIuIIInIpI I
als|d[f E|l|+

'SI‘I'I!IH.I:?IJI'IH'I, o =]
e [ [ 1] ] [a]1]=]~

3. Gebruik het invoerpaneel om een beschrijving en een locatie in te
voeren. Tik om het veld te selecteren.

4. Tik op de datum en tijd indien u deze gegevens wilt wijzigen.

5. Voer andere gewenste informatie in. U dient het invoerpaneel te
verbergen om alle beschikbare velden te zien.

6. Tik op het tabblad Notes (Notities) om notities toe te voegen. U kunt
tekst invoeren, tekenen, of een opname maken. Voor meer informatie
over het maken van notities, zie “Notities” verder in dit hoofdstuk.

7. Tik op ok wanneer u klaar bent om terug te keren naar de agenda.

OPMERKING Tik op Menu > Opties (Options...) > tabblad
Afspraak (Appointments) om het apparaat in te
stellen om u te herinneren aan al uw nieuwe
afspraak. Zal uw Pocket PC u herinneren aan de
afspraak volgens de opties die u heeft ingesteld in [ ]
Settings (Instellingen), tabblad Personal (Persoonlijk),
Sounds and Notifications (Geluiden en meldingen).

Hoofdstuk 4



Het overzichtscherm gebruiken

Wanneer u op een afspraak in de agenda tikt, wordt een overzichtscherm
weergegeven. Tik op Edit (Bewerken) om de afspraak te wijzigen.

Heeting o
1400 16:00 v, 27-7-2007 L Afspraakdetails

| Notities/extra informatie over
de afspraak

Bewerken
Uit st raled...
Verwipleren Tik om de opties voor het verzenden
via infrarood, het verwijderen en het
verzenden via Bluetooth voor een
afspraak weer te geven

Tik om details van de afspraak te wijzigen

Vergaderingsaanvragen maken

U kunt de agenda gebruiken om vergaderingen te plannen met
gebruikers van Outlook en Pocket Outlook. De vergaderingsaanvraag
wordt automatisch gemaakt en verzonden wanneer u het postvak IN
synchroniseert of wanneer u een verbinding maakt met uw e-mailserver.

Een vergaderingsaanvraag maken:

1. Tik op Menu > Opties (Options) > tabblad Afspraak (Appointments)
om de manier waarop uw gespreksaanvragen worden verzonden, op
te geven.

2. Als u e-mailberichten verzendt en ontvangt via ActiveSync, selecteer
dan ActiveSync.

Een vergadering plannen:

1. Maak een afspraak.

2. Verberg het invoerpaneel in de afspraakdetails en tik vervolgens op
Attendees (Aanwezigen).

3. Selecteer de aanwezigen voor de vergadering in de lijst met e-
mailadressen die u onder Contacten heeft ingevoerd. Tik op Toevoegen
(Add) om meer Contacten te selecteren. Tik op ok wanneer u klaar
bent.

Het vergaderingsbericht wordt automatisch gemaakt en in de map
Postvak UIT geplaatst. Raadpleeg de on line help voor de Agenda en
de Berichten op het apparaat, voor meer informatie over het verzenden
en ontvangen van meetingaanvragen.

Microsoft® Pocket Outlook



Contacts (Contacten) @

Onder Contacten wordt een lijst bijgehouden van uw vrienden en collega’s
zodat u gemakkelijk de gewenste informatie kunt vinden, of u nu thuis
bent of onderweg. Met de infaroodpoort (IR) op het apparaat kunt u snel
informatie over Contacts (Contacten) delen met andere gebruikers van
apparaten.

|Geel een naam op... —— Tik en voer een gedeelte van een naam in
om deze snel terug te vinden in de lijst

™m Kileen

+B86 TEI4TE w Tik om contactdetails weer te geven of te

bewerken

Contact verzenden .
Contact kopikren |>_ Tik om de geselecteerde contactpersoon te

Cont st verwipderen kopiéren, te verwijderen of te delen.

Dplies—
WheEHEYEN OfF B
Filter Tik om de categorie Contacten die u wilt

— weergeven, te selecteren.

Tik om een nieuwe contactpersoon te maken

OPMERKING Tik op Menu en Options (Opties) om de manier
waarop informatie wordt weergegeven, te wijzigen.

Contacten maken
Een contactpersoon maken:

1. Tik op EH > Contacten (Contacts) > L — .
Nieuw (New). Afbeeking: Afbeekding selecteren... [
2. Gebruik het invoerpaneel om een naam ;::: i
en andere contactinformatie in te voeren. Furcta:
U dient naar beneden te schuiven om alle |  #ehiv. ds: <Haamioos=
. Tel. weri:
beschikbare velden weer te geven. S
3. Om een contact toe te wijzen aan wim il -
een categorle, tikt u op Categories =1]2]3]4[5]e[T[a[5[0]/ [ole
(Categorieén) en selecteert u een m=Iulwl=lrrlf [yJul Igln.l'll I

categorie in de lijst. Op de lijst kunt u de
Contacten volgens categorie weergeven.
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5. Tik op het tabblad Notes (Notities) om m

Contacten toe te voegen. U kunt tekst Friered
invoeren, tekenen, of een opname

maken. Voor meer informatie over het
maken van notities, zie “Notities” verder —
in dit hoofdstuk.

6. Klik op ok wanneer u klaar bent

¥

om terug te keren naar de lijst met Samatg] Motsis |
Contacten. =1z [3]4]5]6 7]a]s]o]/ [a]«
Tab[a wlelr[t[ylulifalp[ %

Cap |a |5 |d)f h k|l [+

Shift [z (x| |vw b |mj,|.[=]+

Erewerken SeEni

Het overzichtscherm gebruiken

Wanneer u tikt op een contactpersoon in de lijst, wordt een
overzichtscherm weergegeven. Tik op Edit (Bewerken) om de gegevens
van de contactpersoon te wijzigen.

s  Contacten

"8 Tel werk Details contactpersoon
+ THS14TE

Samemvattng | Motties ] Tik om notities weer te geven

Bewerken (] enu

Tik om de informatie van de
contactpersoon te wijzigen
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Een contactpersoon zoeken

U kunt een contactpersoon op vier verschillende manieren zoeken.

1.

Voer in het veld onder de navigatiebalk, de naam in van een
contactpersoon in de lijst. Om alle Contacten opnieuw weer te geven,
wist u de tekst in het veld of tikt u op de knop rechts van het veld.

. Tik op Menu > Filter en selecteer vervolgens het type contactpersoon

dat u wilt weergeven. Om alle Contacten opnieuw weer te geven,
selecteert u Alle Contacten (All contacts). Om een contactpersoon
die niet aan een categorie is toegewezen weer te geven, selecteert u
Geen categorieén (No Categories).

Om de namen van bedrijven waarvoor uw Contacten werken weer te
geven, tikt u in de lijst Contacten op Menu >Weergeven op (View By)
> Op bedrijf (By Company).Het aantal Contacten dat voor dat bedrijf
werkt wordt rechts van de bedrijfsnaam weergegeven.

Tik op B > Programma’s (Programs) > Zoeken (Search). Voer de
naam in van de contactpersoon, selecteer Contacts (Contacten) voor
het type en tik op Zoeken (Search).

———— +856 23651478
Contact versenden ¥
Contact kopiEren
Contact verwijderen

1 [z]3]4]s]a[7][a[o]n]/ 8]«
Tab[a[wlelr [ty ulifa]p]~]*
als|d]|rl h E|l|+
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Taken

Gebruik de taken om uw werkzaamheden bij te houden. Tik op Menu >
Sorteren op (Sort by) of Filter om de weergegeven taken respectievelijk

te sorteren of te filteren.

Taak verwijderen
Task uitstralen...

Hooq
 Mormaal

Laarn

Activeren E Menu

Tik om een nieuwe taak te maken

Taken maken

Een taak maken:

1. Tik op B> Programs (Programma's)
> Tasks (Taken) > Menu > New
Task (Nieuwe taak) om een leeg
taakformulier weer te geven.

2. Gebruik het invoerpaneel om een
beschrijving in te voeren.

3. Voer een startdatum en een einddatum
in, of voer andere informatie in door eerst
op het veld te tikken. Als het invoerpaneel
geopend is, dient u het te verbergen om
alle beschikbare velden te zien.

4. Om een taak toe te wijzen aan een

n I ]l Tik hier voor nieuwe taak | Tik hier om een nieuwe taak te maken
en in te voeren

Duidt hoge prioriteit aan

Tik om details van taken weer te
geven of te bewerken

Tik en houd de pen om een pop-
| upmenu met acties weer te geven en
tik vervolgens op de actie die u wilt
uitvoeren

Priorke; Normaal
Srabus: Wit voRooid
Begint: Geen =|

Enddabum; Geen
Kt woor: (Eén kisr
Herirnenng: (G8en 1

<

Taak | Motities

i 12[3]a]s]e]7[alalo]/[a]«

Tab[afwle[r[tly[ulifofp]["]*

als|d|l]g|h E[l]+*
shalt |2 [x [c [v][b[n]m], [.][-]+

CE | &di | - 4T ||+

- L ]

categorie, tikt u op Categories (Categorieén) en selecteert u een categorie
in de lijst. In de takenlijst kunt de taken volgens categorie weergeven.
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5. Tik op het tabblad Notes (Notities) om notities toe te voegen. U kunt
tekst invoeren, tekenen, of een opname maken. Voor meer informatie
over het maken van notities, zie “Notities” verder in dit hoofdstuk.

6. Tik op ok wanneer u klaar bent om terug te keren naar de takenlijst.

Het overzichtscherm gebruiken

Wanneer u tikt op een taak in de takenlijst wordt een overzichtscherm
weergegeven. Tik op Edit (Bewerken) om de taakdetails te wijzigen.

DOC Meeting ¥
Begnt: 17200y +— Taakdetails

Erikintumn . 772087 w Tik om de taakdetails weer te

1. Standard of MB marual geven of te verbergen
Zacalslbiectivas for 2nd 202) ——— Notities/extra informatie over de taak

Tik om de taakdetails te wijzigen

Notes (Notities) -

Met Notities kunt u snel gedachten, herinneringen, ideeén en
telefoonnummers opnemen. U kunt een geschreven notitie of een opname
maken. Daarnaast kunt u ook een opname insluiten in een notitie. Als

een notitie geopend is terwijl u een opname maakt, zal deze in de notitie
worden opgenomen als een pictogram. Wanneer u de notitie weergeeft,
wordt de opname gemaakt als een onafhankelijke opname.

U kunt de standaardopties voor de notities wijzigen, zoals schrijfmodus,
sjabloon, bestandsopslag en de opnameknop.
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oL/ Alle mappen = masm =—— Tik om de sorteervolgorde van de lijst te wijzigen
Motitial el a1zh Tik om een notitie te openen of een opname af
Hotithe? Bed 8386 T 1o spelen

T mnbibie Redl Tl . .
Saam wijrigen verplaatsen,.. a67h I Tik en houd om een pop-upmenu met acties weer
Wermjderen ke te geven
Eopie maken sk
Ales selecteren Tik op een actie voor het item

Verzenden...
Bestand witstralen..

M T om eon mieuwe noffie f
opname te maken

De standaard invoermethode instellen voor het invoeren van
notitietekst:

1.

2.

Notities maken
Een notitie maken:

1.
2.

Tik op Ed > Programma’s (Programs) > Notities (Notes) > Menu >

Opties (Options).

Selecteer van de volgende opties in het venster Standaardmodus

(Default mode):

+ Schrijven (Writing) als u wilt tekenen of handgeschreven tekst wilt
invoeren in een notitie.

+ Invoeren (Typing) als u een getypte notitie wilt maken.

Tik op ok.

OPMERKING Tik in het scherm Opties (Options) op Il > Help voor
meer informatie over de overige instellingen.

Tik op Ed > Notes (Notities) > New (Nieuw).
Maak uw notitie door te schrijven, te
tekenen, te typen of op te nemen. Zie
Hoofdstuk 2 voor meer informatie over het
gebruik van het invoerpaneel, het schrijven
en tekenen op het scherm en het maken :
van opnamen. 7 E—
Tik op ok om de notitie te bewaren en ga e ttra .

terug naar de notitielijst. "R —e———

OPMERKING Tik op Menu > Opnamewerkbalk weergeven
(View Recording Toolbar) om de opnamehulpmiddelen
weer te geven en een opname te maken.

Tekenen

Ongedamn maken Ln-/ul coomen

Microsoft® Pocket Outlook



48

Messaging (Postvak)

Gebruik Messaging (Postvak) om e-mailberichten op een van de volgende
manieren te verzenden en te ontvangen:

+  Synchroniseer e-mailberichten met Microsoft Exchange of Microsoft
Outlook op uw computer

+ Verzend en ontvang e-mails door rechtstreeks een verbinding te maken
met een e-mailserver via een Internet-provider (ISP) of een netwerk

E-mails synchroniseren

E-mails kunnen worden gesynchroniseerd als onderdeel van het
algemene synchronisatieproces. U moet de synchronisatie van het Inbox
(Postvak IN) inschakelen in ActiveSync. Raadpleeg de on line help voor
ActiveSync op uw computer voor meer informatie over het inschakelen
van de e-mailsynchronisatie.

Tijdens de synchronisatie:

+ Berichten worden gekopieerd van de postmappen van Exchange of
Outlook op uw computer, naar de map ActiveSync in het postvak IN
op uw Pocket PC. Standaard zult u alleen berichten van de laatste
drie dagen ontvangen, de eerste 100 lijnen van elk bericht, en
bestandsbijlagen die kleiner zijn dan 100KB.

+ E-mailberichten in de map Outbox (Postvak UIT) op uw Pocket PC
worden overgedragen naar Exchange of Outlook en vervolgens
verzonden vanaf deze programma’s.

+ E-mails in submappen moeten in ActiveSync op uw computer worden
geselecteerd om ze te kunnen overdragen.

OPMERKING U kunt e-mailberichten ook met uw computer
synchroniseren vanaf een locatie op afstand. Zie
Hoofdstuk 7 voor meer informatie.

Rechtstreeks een verbinding maken met een
e-mailserver

Naast het synchroniseren van e-mails met uw computer, kunt u e-mails
verzenden en ontvangen door een verbinding te maken met een
e-mailserver via een modem of een netwerkkaart die op uw Pocket PC is
aangesloten. U dient een externe verbinding tot stand te brengen met een
netwerk of een Internet-provider, en een verbinding met uw e-mailserver.
Zie Hoofdstuk 7 voor meer informatie.
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Wanneer u een verbinding maakt met de e-mailserver worden nieuwe
berichten gedownload naar de map Inbox (Postvak IN) van het apparaat,
worden berichten in de map Outbox (Postvak UIT) van het apparaat
verzonden, en worden berichten die op de e-mailserver werden
verwijderd, uit de map Inbox (Postvak IN) van het apparaat verwijderd.

Berichten die u rechtstreeks van een e-mailserver heeft ontvangen,
worden gekoppeld aan uw e-mailserver in plaats van aan uw computer.
Wanneer u een bericht op uw Pocket PC verwijdert, wordt het ook
verwijderd van de e-mailserver wanneer u een volgende keer een
verbinding maakt. Dit gebeurt op basis van de instellingen die u in
ActiveSync hebt geselecteerd.

U kunt on line of off line werken. Wanneer u on line werkt, leest en
beantwoordt u de berichten terwijl u verbonden bent met de e-mailserver.
Zodra u tikt op Send (Verzenden) worden de berichten verzonden, zodat
ruimte wordt bespaard op uw Pocket PC.

Wanneer u een verbinding maakt met uw e-mailserver of synchroniseert
met uw computer, zult u standaard alleen berichten van de laatste drie
dagen ontvangen en zal de e-mail minder dan 0,5 KB groot zijn. Als de
grootte van de e-mail groter is dan 0,5 KB, moet u deze downloaden via
de hyperlink. De originele berichten blijven op de e-mailserver of op uw
computer.

U kunt de berichten markeren die u volledig wilt ophalen tijdens uw
volgende synchronisatie of e-mailserververbinding. Tik en houd de pen op
het bericht in de berichtenlijst dat u wilt ophalen. Tik in het pop-upmenu op
Mark for Download (Markeren voor download). De pictogrammen in de
berichtenlijst van het Inbox (Postvak IN) geven u een visuele voorstelling
van de berichtenstatus.

U kunt uw voorkeuren voor het downloaden definiéren wanneer u de
service instelt of wanneer u uw synchronisatie-opties selecteert. U kunt
deze op elk ogenblik wijzigen.

+  Gebruik de opties van ActiveSync om de opties voor de synchronisatie
van het postvak IN te wijzigen. Raadpleeg het helpbestand van
ActiveSync op uw computer voor meer informatie.

+  Wijzig de opties voor de directe e-mailserververbindingen in het Inbox
(Postvak IN) op uw apparaat. Tik op Menu > Extra (Tools) > Opties
(Options). Tik op het tabblad Accounts op de account die u wilt
wijzigen. Tik en houd de pen op de account en selecteer Verwijderen
(Delete) om een account te verwijderen.
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Berichten in het postvak IN lezen

De berichten die u ontvangt, worden weergegeven in uw map Postvak IN.
De meest recent ontvangen berichten verschijnen standaard bovenaan in
de lijst. Ongelezen berichten worden vetgedrukt weergegeven.

Tik om een e-mailaccount en de map die u wilt weergeven, te selecteren

| Tik om de sorteervolgorde voor de
berichten te selecteren

| Tik en houd om een pop-upmenu met
acties weer te geven

Allen beanwoarden
PR —
Markeren als ongelezen |

MMarkering instellen
Maskoering walteolen

Markering wissen
Verplaotsen.. =
Tik op Menu > Verzenden/ontvangen
'“ downloaden Ly P— (Send/Receive) om e-mails te
Wirw [Eren [=]

verzenden/te ontvangen

Tik op een e-mailbericht van uw Postvak IN om het weer te geven.

Tik om terug te keren naar de
berichtenlijst

e  Duthook E-mall

Reree Chen
G5 mamusl_3170_updste

= dZa235 ok

L Tik om dit bericht te verwijderen

Marketen als ongeleren

Regards,
Dpwolgen ¥
Denise: rplaatsen...
ext: 7H13 ::ﬂ. e N
Yerzenden, onbvangen Tik op Menu om een lijst weer te

geven met de acties die u kunt
uitvoeren met een e-mail

eantwoarden

Tik om dit bericht te beantwoorden
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Berichten samenstellen

Een bericht samenstellen:
1. Tik op New (Nieuw) om een leeg e-mailscherm weer te geven.

Voer hier het e-mailadres in

te  Dutlook £ mall s AL 536 ok
BCC: - Tik om de schuifbalk omhoog/omlaag te

verschuiven om de volledige berichtkop

- weer te geven of te verbergen
Wan: [Cuthonok: E-mall
Aan

Omderwenp:

Typ uw tekst hier

ZAAN0BNR00NANG
ot [wle ] [t]yulilolp] |°

caplafs[d[gh]jTe]i]+u]
Shilt | 2 [ | [w|bmjm),|.[=]+

et [ [< 1] [a]1]e]+

Tik om het bericht te verzenden

2. Voer in het veld To (Aan) het e-mailadres in van uw geadresseerde. U
kunt het e-mailadres typen of een naam selecteren in de lijst Contacts

(Contacten) door te tikken op de knop “To (Aan)”.

Als u een kopie van uw e-mail wilt verzenden naar andere
geadresseerden, gebruik dan de pen om omhoog te schuiven en de
lijnen Ce: en Bee: in de berichtkop weer te geven.

De adressen in de velden To (Aan): en Cc: kunnen door alle
geadresseerden worden gelezen.

De adressen in Bec: zijn verborgen voor de geadresseerden.

Om uw e-mail te richten aan meerdere geadresseerden, voert u de

e-mailadressen in, gescheiden door een puntkomma. Een puntkomma

wordt automatisch toegevoegd tussen e-mailadressen als u ze
selecteert in uw lijst Contacten.

Alle namen in de lijst Contacten met e-mailadressen worden
weergegeven in het e-mailadresboek.

3. Geef een onderwerp op en stel uw bericht samen.
4. Tik op Send (Verzenden).
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OPMERKING Om vooraf ingestelde of vaak gebruikte berichten in te
voeren, tikt u op Menu > Mijn tekst (My Text) en
selecteert u het gewenste bericht.

Om een vooraf ingesteld bericht te maken of te
bewerken voordat u het toevoegt aan de tekst van het
bericht, tikt u op Menu > Mijn tekst (My Text) > Mijn
tekstberichten bewerken (Edit My Text Messages).
Selecteer daarna een bericht om een lege regel
onderaan in de lijst te wijzigen of te selecteren, voer
vervolgens uw tekst in en tik op ok.

Samengestelde berichten opslaan

Als u off line werkt, wordt het bericht verplaatst naar de map Outbox
(Postvak UIT) en wordt het verzonden wanneer u de volgende keer een
verbinding maakt.

Als u het bericht niet meteen wilt verzenden, tik dan op ok nadat u het
bericht hebt samengesteld om het op te slaan naar de map Drafts
(Concepten).

Wanneer u klaar bent om het bericht te verzenden, opent u de map
Concepten en tikt u op het bericht. Tik vervolgens op Send (Verzenden)

om het bericht te vezenden.

E-mailberichten en -mappen beheren

Het gedrag van de mappen die u maakt, kan variéren naargelang u
gebruik maakt van ActiveSync, SMS, POP3, of IMAP4.

+ Als u ActiveSync gebruikt, zullen de e-mailberichten in de map
Postvak IN van Outlook automatisch met uw Pocket PC worden
gesynchroniseerd. De mappen die u maakt en de berichten die u
verplaatst zullen dan worden gespiegeld op de server.

+ Als u SMS gebruikt, worden de berichten opgeslagen in de map Inbox
(Postvak IN).

+ Als u POP3 gebruikt en e-mailberichten verplaatst naar een map
die u heeft gemaakt, wordt de koppeling tussen de berichten op het
apparaat en hun kopieén op de mailserver verbroken. Wanneer u
de volgende keer een verbinding maakt, zal de mailserver zien dat
de berichten ontbreken in het Postvak IN van het apparaat en zal hij
ze verwijderen van de server. Dit zorgt ervoor dat u geen dubbele
exemplaren bewaart van een bericht, maar het betekent ook dat u niet
langer toegang zult hebben tot berichten die u verplaatst naar mappen
die op een andere plaats, en niet op het apparaat, werden gemaakt.

+ Als u IMAP4 gebruikt, worden de mappen die u maakt en de e-
mailberichten die u verplaatst, op de server gespiegeld. Daarom zijn
berichten op elk ogenblik beschikbaar, zowel vanaf uw Pocket PC als
vanaf de computer, wanneer u een verbinding maakt met uw mailserver.
Deze synchronisatie van mappen gebeurt telkens wanneer u een
verbinding maakt met uw mailserver, wanneer u nieuwe mappen maakt
of mappen verwijdert of hun naam wijzigt, terwijl u verbonden bent.
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Hoofdstuk 5
Aanvullende programma’s

De aanvullende programma’s zijn Microsoft® Word Mobile, Microsoft®
Excel Mobile, Microsoft® PowerPoint Mobile, Pocket MSN en Windows
Media™ Player voor Pocket PC.

Om te schakelen naar een aanvullend programma op uw apparaat, tikt u
in het menu & op Office Mobile en tikt u vervolgens op het programma
dat u wilt openen.

Word Mobile [#]

Word Mobile werkt met Microsoft Word op uw desktopcomputer om u
gemakkelijk toegang te geven tot kopieén van uw documenten. U kunt
nieuwe documenten maken op uw apparaat of documenten van uw
desktopcomputer naar uw apparaat kopiéren. Daarnaast kunt u ook
documenten tussen uw desktopcomputer en uw apparaat synchroniseren
zodat u de meest recente inhoud op beide locaties hebt.

Gebruik Word Mobile om documenten te maken, zoals brieven, verslagen
van vergaderingen, of reisverslagen.

Word Mobile-documenten maken

Een nieuw Word-document maken:

1. Tik op > Office Mobile > Word Mobile om de toepassing te
starten.

Als er bestaande Microsoft Word- of Word Mobile-documenten op uw
apparaat zijn opgeslagen, verschijnt een lijst met deze documenten.

2. Tik in de menubalk op Nieuw (New) om een leeg document weer te
geven.

3. Gebruik een van de hulpmiddelen in het invoerpaneel om uw tekst te
typen.

OPMERKING Als u tikt op Menu > Opties (Options) en een sjabloon
selecteert, wordt deze sjabloon weergegeven voorzien
van de gepaste tekst en opmaak.

Aanvullende programma’s
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*e Word Mobile e o 337 ok Tik om uw document op te slaan en te sluiten

DOC Mesting agenda
———— Typ hier uw tekst
B 7 U|[E|® & [ i - Opmaakwerkbalk
a1 [2[3]4[s]el7[a][o]0]/fa]=
wler |t i pl”|*

Beeld

Tik om het invoerpaneel weer
Tik om een invoermethode te selecteren te geven of te verbergen

Word Mobile-documenten opslaan

Een Word Mobile-document opslaan:
Tik op ok wanneer u klaar bent met het bewerken van uw document.

Het document wordt standaard opgeslagen met de eerste regel als de
bestandsnaam. Als uw eerste regel in het document bijvoorbeeld de
woorden Zaken te doen bevat, zullen deze woorden in de lijst met uw
Word-documenten verschijnen.

e word Mohile eimm X
Things o do
oo Hectingage— 238 T
HThingstodo 38 Tk
B I U |EXA S
M[]{} 7la|o|[=|%]=]|=
el == A5 6([+]=]"]f
glelz iy ifj1f2|3||4|r|=|=
S el |E|w||(]|0])|[TebSpace |+
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De opslagopties opgeven:

1. Tik terwijl het document open is op Menu > Bestand (File) > Opslaan
als (Save As) om het scherm Opslaan als (Save As) te openen.

2. Typ een bestandsnaam in het veld Naam (Name).

3. Tik op de pijl omlaag in het veld Map (Folder) en selecteer een map
waarin u het bestand wilt opslaan.

4. Tik op de pijl omlaag in het veld Type om een bestandsindeling te
selecteren.

5. Tik op de pijl omlaag in het veld Locatie (Location) om de locatie op
te geven voor uw opgeslagen bestand. Dit kan het hoofdgeheugen van
het apparaat zijn of, indien beschikbaar, een opslagkaart.

6. Tik op Opslaan (Save).

Een bestaand Word Mobile-document openen

Word Mobile bevat een lijst van de bestanden die op uw apparaat

zijn opgeslagen. Tik op een bestand in de lijst om het te openen. Om
bestanden te verwijderen, te kopiéren en te verzenden, tikt u en houdt u
de pen op een bestand in de lijst en selecteert u vervolgens de correct
optie in het pop-upmenu.

Tik om de map die u wilt weergeven, te selecteren

Tik om de sorteervolgorde

van de lijst te wijzigen
= D0 Mecting sge—. 38 Tk
=1 Things to do 38 7 T Tik om een nieuw document

te maken

Tik op een document M

om het te openen

OPMERKING Als u een bestaand Word-bestand hebt geopend,
tikt u op Menu > Bestand (File) > Naam wijzigen/
Verplaatsen ... als u de bestandsnaam, de map en de
opslaglocatie voor het opslaan van het bestand wilt wijzigen.
YU kunt slechts één Word Mobile-document per keer
openen. Wanneer u een tweede document opent, zult
u worden gevraagd eerst het eerste document op te slaan.

Aanvullende programma’s
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Documenten weergeven

Als u een Word-document dat op een desktopcomputer is gemaakt opent,
selecteer dan Maximale breedte (Wrap to Window) in het menu Beeld
(View) zodat u het volledige document kunt zien.

U kunt de weergavegrootte van een document ook aanpassen door te
zoomen.

In- of uitzoomen op een document:

Tik op Beeld (View) > In-/uitzoomen (Zoom) en selecteer het gewenste
percentage.

Excel Mobile

Excel Mobile biedt fundamentele hulpmiddelen voor rekenbladen, zoals
formules, functies, sorteer- en filteropties. Tik op Beeld (View) > Werkbalk
(Toolbar) om de werkbalk weer te geven.

Hier verschijnt de
| celinhoud terwijl u typt
of wanneer u de cel
selecteert

1|

A] ® ] [#]
Gereed  |Bladl  w |[Som=0 -
3] 1 I?ISIHSJW?[HI?IGIIP]*
mrInIWIr r{tlyfulifolp]"]*

s 2 Tx [ vf'ull'%]leJrJH"'

: LLUETTRES Nk - .
Tik om de weergave-opties sl =]]] l i Tik om een menu met

te openen — R B Excel-functies te openen

OPMERKING U kunt slechts één Excel Mobile-document per keer
openen. Wanneer u een tweede document opent, zult
u worden gevraagd eerst het eerste document op te
slaan.

Een Excel Mobile-document maken
1. Tik op > Office Mobile > Excel Mobile.
2. Tik op Nieuw (New) om een leeg werkblad weer te geven.

OPMERKING Als u tikt op Menu > Opties (Options) in de
bestandslijst en een sjabloon selecteert, wordt deze
sjabloon weergegeven voorzien van de gepaste tekst
en opmaak wanneer u een nieuw werkblad maakt.
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Een bestaand Excel Mobile-document openen

1. Tik op Edl > Office Mobile > Excel Mobile om een lijst met Excel
Mobile-bestanden weer te geven.

2. Tik op het bestand dat u wilt openen.

Een Excel Mobile-document opslaan

Een Excel Mobile-document opslaan:

Tik op ok wanneer u klaar bent met het bewerken van uw document.
Uw document wordt standaard opgeslagen met de bestandsnaam Map1
(Book1). U kunt de bestandsnaam wijzigen naar een naam die een

betere omschrijving van uw document geeft. Raadpleeg de onderstaande
procedure voor opslagopties.

De opslagopties opgeven:
1. Tik terwijl het document open is op Menu > Bestand (File) > Opslaan
als... (Save As...) om het scherm Opslaan als (Save As) te openen.

2. Wijzig de bestandsnaam door een nieuwe naam in het veld Naam
(Name) te typen.

3. Tik op de pijl omlaag in het veld Map (Folder) en selecteer een map
waarin u het bestand wilt opslaan.

4. Tik op de pijl omlaag in het veld Type om een bestandsindeling te
selecteren.

5. Tik op de pijl omlaag in het veld Locatie (Location) om de locatie op
te geven voor uw opgeslagen bestand, bijv. het hoofdgeheugen, een
flashstation of, indien beschikbaar, een opslagkaart.

6. Tik op Opslaan (Save).
Een bestand hernoemen/verplaatsen:

1. Tik terwijl het document open is op Menu > Bestand (File) > Naam
wijzigen/Verplaatsen (Rename/Move) om het gelijknamige scherm te
openen.

2. Wijzig de bestandsnaam in het veld Naam (Name).

3. Tik op de pijl omlaag in het veld Map (Folder) en selecteer een map
waarnaar u het bestand wilt verplaatsen.

4. Tik op de pijl omlaag in het vak Locatie (Location) om de maplocatie
te selecteren.

5. Tik op ok wanneer u klaar bent.
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Tips voor het werken met Excel Mobile
Houd rekening met de volgende zaken wanneer u met grote werkbladen
werkt in Pocket Excel:

Op volledige schermgrootte weergeven om zoveel mogelijk van

uw werkblad te zien. Tik op Beeld (View) > Volledig scherm (Full
Screen). Tik op Herstellen (Restore) om de weergave op volledig
scherm af te sluiten.

Windows-elementen weergeven en verbergen. Tik op Beeld (View)
> Weergeven (Show).

Titels op een werkblad blokkeren of de titelblokkering opheffen.
Selecteer de cel waar u de deelvensters wilt blokkeren. Tik op Beeld
(View) > Titels blokkeren (Freeze Panes). U kunt de titels bovenaan
en aan de linkerkant van een werkblad blokkeren om de rij- en
kolomknoppen zichtbaar te houden terwijl u door een blad bladert.
Om de blokkering van de titels op te heffen, tikt u op Beeld (View) >
Titelblokkering opheffen (Unfreeze Panes).

Vensters splitsen om verschillende gebieden van een groot werkblad
weer te geven. Tik op Beeld (View) > Splitsen (Split). Sleep de
splitsbalk naar de gewenste plaats. Om de splitsing te verwijderen, tikt
u op Beeld (View) > Splitsing verwijderen (Remove Split).

Rijen en kolommen weergeven en verbergen. Als u een rij of kolom
wilt verbergen, selecteert u een cel in de rij of de kolom die u wilt
verbergen. Tik op Menu > Opmaak (Format) > Rij (Row) of Kolom
(Column) > Verbergen (Hide). Om een verborgen rij of kolom weer te
geven, tikt u op Menu > Bewerken (Edit) > Ga naar (Go To) en typ
een verwijzing van de verborgen rij of kolom. Tik op Menu > Opmaak
(Format) > Rij (Row) of Kolom (Column) > Zichtbaar maken
(Unhide).

Tik op & > Help voor meer informatie over het gebruik van Excel Mobile.

PowerPoint Mobile =

PowerPoint Mobile werkt met Microsoft PowerPoint op uw computer
om u gemakkelijk toegang te geven tot kopieén van PowerPoint-
presentaties. U kunt PowerPoint-presentatiebestanden kopiéren van
uw computer naar uw apparaat en ze onderweg bekijken. Daarnaast
kunt u ook presentatiebestanden op desktopcomputer en uw apparaat

synchroniseren zodat u de meest recente inhoud op beide locaties hebt.

OPMERKING U kunt alleen PowerPoint-presentatiebestanden
weergegeven in PowerPoint Mobile.

Een PowerPoint-presentatiebestand openen
Als er eerder gekopieerde PowerPoint Mobile-presentaties op

het apparaat aanwezig zijn, wordt een lijst van deze documenten
weergegeven wanneer u op het pictogram PowerPoint Mobile tikt.
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Een PowerPoint Mobile-bestand openen:

1. Tik op El > Office Mobile > PowerPoint Mobile om een lijst met
PowerPoint-bestanden weer te geven.

2. Tik op het bestand dat u wilt openen.

Een PowerPoint Mobile-bestand weergeven
Naar de vorige of volgende dia gaan:

1. Tik terwijl u een PowerPoint-bestand bekijkt, op de pijl linksonder op
het scherm om het menu te openen.

2. Tik in het menu Volgende (Next) of Vorige (Previous) om vooruit te
gaan of terug te keren in uw PowerPoint Mobiel-bestand. Tik op Naar
dia gaan (Go to Slide) om onmiddellijk naar een specifieke dia in uw
presentatie te gaan.

OPMERKING Wanneer u een PowerPoint-bestand bekijkt, kunt u ook
op het scherm tikken om naar het volgende bestand te
gaan.

Inzoomen op een dia:

1. Tik terwijl u een PowerPoint-bestand bekijkt, op de pijl linksonder op
het scherm om het menu te openen.

2. Tik in het menu op Inzoomen (Zoom in). Sleep het rode vak onderaan
rechts op het scherm met behulp van de pen naar een specifiek gebied
op de dia.

3. Tik op het vergrootglas om in of uit te zoomen op de dia. Tik op
Aanpassen aan scherm (Fit to screen) om de dia aan te passen aan
de volledige schermgrootte.

OPMERKING Het menu is niet beschikbaar wanneer u een andere
weergave dan Aanpassen aan scherm (Fit to screen)
gebruikt.

Een aangepaste voorstelling weergeven
(diavoorstelling)

1. Tik terwijl u een PowerPoint-bestand bekijkt, op de pijl linksonder op
het scherm om het menu te openen.

2. Tik op Aangepaste voorstelling (Custom Show) en selecteer de
aangepaste voorstelling die u wilt weergeven.

Aanvullende programma’s
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De opties voor de voorstelling instellen

1. Tik terwijl u een PowerPoint-bestand bekijkt, op de pijl linksonder op
het scherm om het menu te openen.

2. Tik op Opties voorstelling (Show Options). Selecteer de stand
die u wilt gebruiken voor de diavoorstelling op het tabblad Stand
(Orientation).

3. Tik op het tabblad Playback (Afspelen). Tik op Afspeelopties voor
alle bestanden overschrijven (Override playback options for all
files) als u de ingesloten instellingen van een PowerPoint-bestand dat
u op uw computer hebt gemaakt, niet wilt gebruiken.

4. Selecteer de gewenste opties. Tik op ok wanneer u klaar bent.

Windows Live

Windows Live op uw apparaat is een programma voor expresberichten
waarmee u:

+ kunt zien wie van uw contactpersonen on line is en chatten met deze
personen door expresberichten te verzenden en te ontvangen.

+ Open uw hotmail-account als u er een hebt en verzend en ontvang
e-mails.

Windows Live gebruiken:

U moet over een Microsoft Passport™-account of een Microsoft
Exchange e-mailaccount beschikken.

U moet een Passport hebben om de MSN Messenger-service te
gebruiken. Als u een Hotmail®- of MSN-account hebt, beschikt u al over
een Passport. Zodra u een Microsoft Passport of een Microsoft Exchange-
account hebt verkregen, bent u klaar om uw account in te stellen.

Schrijf u in voor een Microsoft Passport-account op
http://www.passport.com.

Vraag een gratis Microsoft Hotmail e-mailadres aan op

http://www.hotmail.com. R |
Aanmelden bij Windows Live® L
Messenger Yennlcws Lo

1. Tik op E > Programma’s > Messenger.

2. Tik op Aanmelden. Tik vervolgens op OK in het m —
pop-upvenster
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Tik op Accepteren. Voer vervolgens uw e-mailadres in en tik op
Volgende.

Selecteer Wachtwoord opslaan als u het wachtwoord in de toekomst
niet meer wilt invoeren en tik daarna op Volgende.

3F Wrdaws Live S e
e e ‘

Wiocr sk gptbeusc wan Wincoens Lse |5 Asrikien bl Windgws Lvg

it e elr b e v d Lnt E——

war Winciows L {8 vinden op - -

P AT Y S [eer | & [rewmabcom |
s o Irlonbeinag ) en do R wOn:

ik g vin Mool fe I ol

incler op [ ]
= [:;‘; im0 [ Wachtwoord opsiaan
!.!:ﬂ'E! =I!.I —

Ak 8 hronder op da kg

Soceperon kiid, acroptosr W deoa bl 1 [ 23 [als e e[a]o]/ @]
byl ARkl dny Tab|g w e]r |t wilid o | “ )"
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s el (s frode iy ol el R [
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5. Schakel de selectievakjes in als u Windows Live wilt weergeven op het
scherm Vandaag. Tik daarna op Volgende.

6. Schakel de selectievakjes in van de items die u wilt synchroniseren op
uw apparaat.

Wincoers Live op bt Vareclasgeadherm
Rl et

AT
£ L Sarcr ) Enntactnen.{ Sewenger|
B W L seraces ] Cutioets contacton met Curtock
g
Flema

OPMERKING Als u Messenger al gebruikt op uw computer, worden uw
contacpersonen weergegeven op het apparaat.
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Contactpersonen Messenger

Het scherm MSN Messenger toont al uw contactpersonen van Messenger in één
oogopslag, opgesplitst in de categorieén On line (Online) en Niet on line (Not
Online). Wanneer u een verbinding hebt, kunt u via het pop-upmenu vanaf deze
weergave chatten, een e-mail verzenden, de contactpersoon blokkeren zodat deze
niet met u kan chatten of contactpersonen uit de lijst verwijderen.

Tik en houd de pen op een
contactpersoon om een pop-upmenu

S () (R} Semen (R (2)

Tik op een & (0 ey weer te geven waar u kunt kiezen
contactpersoon i g B [ Frlpes om een expresbericht (IM) en
om het chatten te Er een e-mail te verzenden naar een
starten e contactpersoon, de gegevens en de
Gy(m) Emal ruimte van een contactpersoon weer
":th' Info contactp. weergewen te geven, enz.
i.& Cpace contactp. weergeven —|

WeErgave wijrgen
Sorleren op L}

Enfo

“help
{4 falior
oy Breadyil -

a1}

Mee conbactp. Loeveegen

&
Geaprek E Opities
" . afmelden
Tik om een expresbericht te verzenden Windows Live

Tik om de gewenste

naar de geselecteerde contactpersoon )
actie te selecteren

Chatten met contactpersonen

Tik op de naam van een contactpersoon om een chatvenster te openen. Voer
uw bericht in het tekstinvoergebied onderaan op het scherm in of tik op Mijn
tekst (My Text) om een vooraf ingesteld bericht in te voeren en tik vervolgens
op Verzenden (Send). Om een andere contactpersoon uit te nodigen voor een
conferentiegesprek, tik u op Menu > Uitnodigen (Invite) en tikt u vervolgens op
de contactpersoon die u wilt uitnodigen.

st Windows Live

-
Gesprek met hBreadyd

e chat met: [«
Broady : -
Alesn:
Volledig gesprek Bready :
weergeven Hi~
Adbeen: -
Peedbrn
Bready © Ermnoticon toevoegen
By plan for weskend?
verzenden ]
Voer hier uw il Opties [
berichtin =™~ ) bl
Tik om de lijst met ———1, Q | r! Gespre eindigen
contactpersonen || Alle gesprekken be€indigen
weer te geven
Tik om te schakelen tussen contactpersonen
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Hotmail gebruiken

Met Windows Live, kunt u het postvak van uw hotmail op uw Pocket PC
openen en e-mails verzenden en ontvangen.

1. Tikop (5 S Programma’s > Windows Live om Hotmail te openen.

st Windows Live

Tik om de b
berichtenmappen - Postvak IN «

Tik om de berichten te

Ontvangen = 17— sorteren op type bericht,

weer te geven

Tik op een bericht
om het te openen

naam afzender, tijd,
onderwerp, enz.

Beantwoorden ¥
Nadat u een bericht hebt
geselecteerd, kunt u in
Gananr N het menu kiezen wat u
Extra ' wilt doen met de e-mail.
Werzenden, oty angen

e-mail te maken

2. E-mails opmaken en verzenden naar contactpersonen

Gesdresseerde toevoegen...

Voer het e-mailadres van de ontvanger in
Geef een onderwerp op

Voer het bericht in

Tik om een geadresseerde van uw Outlook
contactpersonen toe te voegen

——— Tik om de namen te controleren

shift | 2

Besichtopties._

Mamsen controleren

Invoegen i
23] I1 If : —
Taki | i Dpslsan in Concepten
Cap|a s

Bericht anmileren

Tik om de e-mail te verzenden

Aanvullende programma’s

Tik om een afbeelding, spraaknotitie of
bestand in bijlage te verzenden

Tik om een vooraf ingesteld bericht te kiezen

Tik om het bericht op te slaan naar de
map Concepten om het later te bewerken

Tik om het bericht te annuleren zonder het
te verzenden

Tik op de prioriteit, de taalcodering en meer
in te stellen voor het bericht

OPMERKING Tik op het scherm MSN

Hotmail op E4 > Help voor
meer informatie.
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Windows Media Player voor Pocket PC

Gebruik Microsoft® Windows Media Player voor Pocket PC om digitale
audio- en videobestanden die op uw apparaat of op een netwerk zijn
opgeslagen, af te spelen. Tik op Il > Windows Media om te schakelen
naar Windows Media Player voor Pocket PC.

s Windows Media

T i prlarc

Tik om het geluid te

Tik voor weergave op dempen of in te schakelen

volledig scherm
Tik om het volume te

verhogen/verlagen

Tik om de afspeellijst weer
te geven

Tik om naar
het volgende
bestand te gaan

Tik om naar het begin van het
huidige bestand of naar het vorige
bestand te gaan

Tik om af te spelen/te pauzeren

Gebruik Microsoft Windows Media Player op uw computer om digitale
audio en video naar uw Pocket PC te kopiéren. U kunt Windows Media- en
MP3-bestanden afspelen op uw Pocket PC.

OPMERKING Tik op - Help voor meer informatie over het
gebrui k van Windows Media Player voor Pocket PC.
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Hoofstuk 6
Internet Explorer Mobile

Gebruik Microsoft Internet Explorer Mobile om Web- of WAP-pagina’s op
een van de volgende manieren weer te geven.

+ Tijdens de synchronisatie met uw desktopcomputer, kunt u uw
favoriete koppelingen downloaden en uw mobiele favorieten, die in de
submap Mobile Favorites (Mobiele favorieten) van Internet Explorer
op de computer zijn opgeslagen.

+ Maak een verbinding met een Internetprovider (ISP) of netwerk en
surf op het web. Hiervoor dient u eerst een verbinding te maken. Zie
Hoofdstuk 7 voor meer informatie over het tot stand brengen van een
verbinding.

Wanneer u verbonden bent met een ISP of netwerk, kunt u ook bestanden

en programma’s downloaden van het Internet of het Intranet.

Internet Explorer Mobile gebruiken

U kunt Internet Explorer Mobile gebruiken om te bladeren door de mobiele
favorieten en kanalen, die naar uw Pocket PC werden gedownload,
zonder een verbinding te maken met het Internet. U kunt ook een
verbinding maken met het Internet via een ISP of een netwerkverbinding
om te surfen op het Web.

Internet Explorer Mobile starten: W
1 e [kt ffnlmenucom/ -

. Tik op E > Internet Explorer om e
de Mobile Services van MSN weer te St
geven.

2. Tik op Menu > Starts (Home) om
Internet Explorer Mobile weer te geven
met koppelingen naar enkele nuttige
websites.

3. Tik op een van de Websiteknoppen om
naar een specifieke site te gaan.

=

[l

ad Windowr: Lew M bencer

Internet Explorer Mobile
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Weergaveinstellingen wijzigen
Weergaveinstellingen wijzigen:

1. Tik op Menu > Beeld (View) en
selecteer de weergave-opties. Tik
bijvoorbeeld op Volledig scherm (Full
screen) om het verkennervenster op
volledige schermgrootte in te stellen.
Om de volledige schermgrootte uit te
schakelen, tikt u en houdt u de pen op
een willekeurige plaats in de verkenner

Adreshalk
Favorset en..
Toev, aan Favarieten.

WeErmieusen

. . Geschiedeni
en selecteert u opnieuw Volledig " ;
scherm (Full Screen). o —

Entra L

2. Tik op Zoom om een ander pop-

upmenu te openen om de gewenste

tekstgrootte te selecteren.

Surfen op het Internet

Surfen op het Internet:

1. Maak een verbinding met uw ISP of bedrijfsnetwerk via de knop
Connections (Verbindingen). Zie Hoofdstuk 8 voor details.

2. Voer een van de volgende bewerkingen uit om een verbinding te
maken en het zoeken te starten:
+ Tik op de knop Favorites (Favorieten) en tik vervolgens op de
favoriet die u wilt weergeven.

+ Tik op View (Beeld) en vervolgens op Address Bar (Adresbalk).
Voer het Webadres in dat u wilt bezoeken en tik op Go (Start).

Map Mobiele favorieten

Alleen de items die in de submap Mobile Favorites (Mobiele favorieten) van
Internet Explorer op uw computer zijn opgeslagen, zullen met uw apparaat

worden gesynchroniseerd. Deze map is automatisch aangemaakt wanneer
u ActiveSync (Actieve synchronisatie) hebt geinstalleerd.

Favoriete koppelingen

Tijdens de synchronisatie wordt de lijst met de favoriete koppelingen in de
map Mobile Favorieten op uw computer gesynchroniseerd met Internet
Explorer Mobile op uw apparaat. ledere keer wanneer u synchroniseert,
worden beide computers bijgewerkt met de wijzigingen die aan een van
beide lijsten werden aangebracht. Markeer de favoriete koppeling als

een mobiele favoriet, anders zal alleen de koppeling naar uw Pocket PC
worden gedownload, en zult u een verbinding moeten maken met uw ISP
of netwerk om de inhoud weer te geven. Raadpleeg het helpbestand van
ActiveSync op uw computer voor meer informatie over synchronisatie.
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Mobiele favorieten

Als u Microsoft Internet Explorer 5.0 of hoger gebruikt op uw computer,
kunt u mobiele favorieten downloaden naar uw Pocket PC. Het
synchroniseren van mobiele favorieten zal de webinhoud naar uw
Pocket PC downloaden, zodat u pagina’s kunt bekijken zonder dat u een
verbinding nodig hebt met uw ISP of uw computer.

Gebruik de Internet Explorer plug-in die met ActiveSync werd
geinstalleerd, om snel mobiele favorieten te maken.

Een mobiele favoriet maken:

1. Klik in Internet Explorer op uw
desktopcomputer, op Tools [ P ————— o
(Extra) > Create Mobile Favorite ) e =t
(Mobiele favoriet maken). s fe=r

2. Om de naam van de koppeling te .
wijzigen, geeft u een nieuwe naam

op in het vak Name (Naam).
3. Selecteer de gewenste updateplanning onder Update. Dit is optioneel.
4. U kunt de pagina’s die zijn
gekoppeld aan de mobiele
favoriet die u net hebt gemaakt,
downloaden in Internet Explorer
op de desktopcomputer.
Klik hiervoor op Favorieten
(Favorites) > Mobiele
favorieten (Mobile Favorites),
klik vervolgens rechts op
een specifiek item van de
mobiele favoriet en klik op

3w com - Micreso Iraeres Caphoees

N Edn s TS

-

Herwr & porta

]

2rod iy -
g1 F

Eigenschappen (Properties).
Definieer de diepte van het
aantal koppelingen dat u wilt downloaden op het tabblad Download.
Selecteer een diepte van slechts één niveau om geheugen te sparen
op uw Pocket PC.

5. Synchroniseer uw Pocket PC en uw computer. Mobiele favorieten die
zijn opgeslagen in de Mobiele favorieten van Internet Explorer, worden
gedownload naar uw apparaat.

Internet Explorer Mobile
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OPMERKING U zult de inhoud handmatig moeten downloaden of
een planning instellen om de informatie op uw
computer en uw apparaat up-to-date te houden.

Voordat u synchroniseert met uw Pocket PC, moet u in
Internet Explorer op uw computer klikken op Tools
(Extra) > Synchronize (Synchroniseren). U zult zien
wanneer de inhoud voor het laatst naar de
desktopcomputer is gedownload en u kunt de inhoud,
indien nodig, handmatig downloaden of een planning
instellen om de inhoud automatisch bij te werken. Om
een planning in te stellen om een specifieke mobiele
favoriet bij te werken, selecteert u een specifieke
mobiele favoriet in de lijst en klikt u op de knop
Eigenschappen (Properties). Op het tabblad
Planning (Schedule) kunt u de mobiele favoriet
instellen om een specifieke planning te gebruiken om
zijn inhoud bij te werken.

U kunt een knop toevoegen in de werkbalk van Internet
Explorer om mobiele favorieten te maken. Klik in
Internet Explorer op uw computer op View (Beeld) >
Toolbars (Werkbalken) > Customize (Aanpassen).

Apparaatgeheugen besparen

Mobiele favorieten nemen opslagruimte in op uw apparaat. Om het
gebruikte geheugen te minimaliseren, gaat u als volgt te werk:

+ Schakel de afbeeldingen en geluiden uit in de instellingen voor het
informatietype van de favorieten in de opties van ActiveSync, of zorg
ervoor dat bepaalde mobiele favorieten niet kunnen worden gedownload
naar het apparaat. Zie ActiveSync Help voor meer informatie.

+  Beperk het aantal gedownloade gekoppelde pagina’s. Klik in
Internet Explorer op uw desktopcomputer op Favorieten (Favorites)
> Mobiele favorieten (Mobile Favorites), klik rechts op een
specifieke mobiele favorite die u wilt wijzigen en klik vervolgens op
Eigenschappen (Properties). Definieer op het tabblad Download 0 of
1 voor het aantal gekoppelde pagina’s dat u wilt downloaden.

Mobiele favorieten en kanalen weergeven

Mobiele favorieten en kanalen weergeven:

1. Tik op Menu > Favorieten (Favorites) om uw lijst met favorieten weer
te geven.

2. Tik op een Favorietenpagina die u wilt weergeven.

U ziet de pagina die naar uw computer werd gedownload tijdens de
laatste synchronisatie. Als de pagina zich niet op uw Pocket PC bevindt,
wordt de favoriet verduisterd. U dient opnieuw te synchroniseren met
uw computer om de pagina naar uw Pocket PC te downloaden, of maak
een verbinding met het Internet om de pagina weer te geven.
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Mobiele favorieten en mappen toevoegen/verwijderen
Een favoriet toevoegen:

1.

Tik op Menu > Favorieten (Favorites) > tabblad Toevoegen/
Verwijderen (Add/Delete).

Tik op de knop Add (Toevoegen) om het scherm Add Favorites
(Favoriet toevoegen) weer te geven.

Typ in het veld Name (Naam) een naam voor de favoriet die u wilt
toevoegen.

Typ het URL-adres in het veld Address (URL).

Selecteer een map waar u de favoriet wilt plaatsen in het vak Create
in (Maken in).

Tik op Add (Toevoegen) om terug te keren naar het scherm met de
Favorieten. De favoriet die u net hebt toegevoegd, wordt weergegeven.

OPMERKING Om een favoriet te verwijderen, tikt u op de favoriet die u wilt
verwijderen en tikt u vervolgens op de knop Verwijderen (Delete).

Een map toevoegen:

1.

w

Tik op Menu > Favorieten (Favorites) > tabblad Toevoegen/
Verwijderen.

Tik op de knop New Folder (Nieuwe map).

Typ een naam in voor de map die u wilt maken.

Tik op Add (Toevoegen) om terug te keren naar het scherm met de
favorieten. De map die u net hebt toegevoegd, wordt weergegeven.

OPMERKING Om een map te verwijderen, tikt u op de map die u wilt
verwijderen en tikt u vervolgens op de knop
Verwijderen (Delete).

Internet Explorer Mobile
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Hoofdstuk 7
Een verbinding maken

U kunt verbindingen tot stand brengen met het Internet en een
bedrijfsnetwerk om verschillende activiteiten uit te voeren zoals surfen
op het Internet of Intranet, e-mails en expresberichten verzenden en
ontvangen, en informatie synchroniseren met de hulp van ActiveSync.

Verbindingen kunnen worden gemaakt via een modem, een draadloos
netwerk, of een netwerkkaart (Ethernet). U kunt een modemverbinding
gebruiken om verbindingen tot stand te brengen met een externe modem,
of via het telefoonnetwerk van uw mobiele telefoon met een infrarood.

Uw Pocket PC bevat twee groepen verbindingsinstellingen: My ISP (Mijn
ISP) en My Work Network (Mijn werk-netwerk). De instellingen van My
ISP worden gebruikt om een verbinding te maken met het Internet en

de instellingen van My Work Network kunnen worden gebruikt om een
verbinding te maken met elk privé-netwerk, zoals een bedrijffsnetwerk dat
u op uw werk gebruikt. Vul de instellingen in en maak een verbinding.
Raadpleeg de hoofdstukken “Verbinden met het Internet” of “Verbinden
met het werk” voor meer informatie.

U kunt ook een verbinding tot stand brengen met een ander apparaat via
infrarood (IR). Zie sectie “Infraroodverbinding (IR)” later in dit hoofdstuk of
“Hoofdstuk 8 Bluetooth®-verbinding” voor meer informatie.

Verbinden met het Internet
Verbinden met het Internet:

1. Zoek de volgende informatie van uw Internet-provider op:
Telefoonnummer server Internet-provider, gebruikersnaam en
wachtwoord.

2. Tik op El > Settings (Instellingen) >Tabblad Connections
(Verbindingen) > Connections (Verbindingen).

3. Tikin My ISP op Add a new modem connection (Een nieuwe
modemverbinding toevoegen).

4. Maak een modemverbinding. Zie hoofdstuk “Modemverbindingen
instellen” voor meer informatie.

5. Om de verbinding te starten, gebruikt u het gewenste programma.
Schakel bijvoorbeeld naar Pocket Internet Explorer en surf naar een
Webpagina. Uw Pocket PC start de verbinding automatisch.

OPMERKING Om een verbinding te maken met uw Internet-provider
via een netwerkkaart of een draadloze netwerkverbinding,
voegt u een verbinding toe onder My Work Network (Mijn
werk-netwerk).
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Verbinden met het werk

1.

Zoek de volgende informatie van uw netwerkadministrator op:
telefoonnummer server, gebruikersnaam en wachtwoord.

. Tik op Il > Settings (Instellingen) >Tabblad Connections

(Verbindingen) > Connections (Verbindingen).

Stel in My Work Network (Mijn werk-netwerk) een modem,
netwerkkaart, draadloos netwerk, of een VPN-serververbinding in.
Zie hoofdstuk “Verbindingen tot stand brengen” voor de werkwijze.
Om de verbinding te starten, gebruikt u het gewenste programma.
Schakel bijvoorbeeld naar Pocket Internet Explorer en surf naar een
webpagina. Uw Pocket PC start de verbinding automatisch.

Verbindingen tot stand brengen
Modemverbindingen

Een modemverbinding tot stand brengen:

Zoek de volgende informatie van uw Internet-provider of
netwerkadministrator op: telefoonnummer, gebruikersnaam, wachtwoord,
domeinnaam en TCP/IP-instellingen.

Als uw Pocket PC geen toegang heeft tot een mobiel telefoonnetwerk,
plaats dan een modemkaart.

1.

Tik op & > Settings (Instellingen) >Tabblad Connections
(Verbindingen) > Connections (Verbindingen).

Om een nieuwe verbinding te maken in My ISP (Mijn ISP) of MyWork
Network (Mijn werk-netwerk), tik op Add a new modem connection
(Een nieuwe modemverbinding toevoegen) en volg de richtlijnen van
de wizard Nieuwe verbinding.

Tik op @ om extra informatie weer te geven voor elk scherm van de
wizard of tijdens het wijzigen van de instellingen.

OPMERKING Om de instellingen voor de modemverbinding te wijzigen
in Mijn ISP (My ISP) of Mijn werk-netwerk (My Work
Network), tikt u op Bestaande verbindingen beheren
(Manage existing connections) > tabblad
Modem.Selecteer de gewenste modemverbindingen,tik
op Bewerken (Edit), en volg de instructies op het scherm.
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Verbindingen via VPN-server

Een VPN-verbinding helpt u om een veilige verbinding te maken

tussen servers (zoals een bedrijfsnetwerk) via het Internet. Vraag uw
netwerkadministrator naar uw gebruikersnaam, wachtwoord, domeinnaam,
TCP/IP-instellingen en de hostnaam of het IP-adres van de VPN-server.

Een VPN-serververbindingen tot stand brengen:

1. Tik op Bl > Settings (Instellingen) >Tabblad Connections
(Verbindingen) > Connections (Verbindingen).

2. Om een nieuwe VPN-serververbinding te maken, tikt u in mijn werk-
netwerk op Add a new VPN server connection (Een nieuwe VPN-
serververbinding toevoegen) en volgt u de instructies op het scherm.

3. Tik op @ om extra informatie weer te geven voor elk scherm van de
wizard of tijdens het wijzigen van de instellingen.

OPMERKING Om bestaande instellingen te wijzigen, tikt u in Mijn
werk-netwerk op Manage existing connections
(Bestaande verbindingen beheren) > VPN tabblad.
Selecteer de gewenste VPN-verbinding op het tabblad
VPN, tik op Bewerken (Edit) en volg de richtlijnen op
het scherm.

Instellingen proxyserver

Als u tijdens de synchronisatie verbonden bent met uw Internet-provider of
uw privé-netwerk, dient uw mobiel apparaat de correcte proxy-instellingen
van uw PC te downloaden. Als deze instellingen niet op uw PC aanwezig
zijn of als ze moeten gewijzigd worden, vraag dan uw Internet-provider

of uw netwerkadministrator naar de naam van de proxyserver, het
servertype, de poort, het type van de gebruikte socks-protocollen en uw

gebruikersnaam en wachtwoord.

De instellingen van de proxyserver wijzigen:

1. Tik op > Settings (Instellingen) > Connections (Verbindingen).

2. Tik in de categorie Mijn werk-netwerk (My Work Network) op Mijn
proxyserver instellen (Setup my proxy server).

3. Schakel de selectievakjes in naast This network connects to the
Internet (Dit netwerk verbindt met het Internet) en This network uses
a proxy server to connect to the Internet (Dit netwerk gebruikt een
proxyserver om te verbinden met het Internet).

4. Typ de naam van de proxyserver in het vak Proxy server.

5. Tik op Advanced (Geavanceerd) om de server en poortinstellingen
voor HTTP, WAP, Secure WAP en Socks te wijzigen.

6. Tik op ok wanneer u klaar bent.

Een verbinding maken
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Verbindingen via netwerkkaart

Gebruik een netwerkkaart (Ethernet) om rechtstreeks een verbinding te
maken met een netwerk. Zodra u verbonden bent, kunt u surfen op het
Internet of intranet, of e-mail downloaden. Het is niet nodig om een nieuwe
verbinding te maken op uw Pocket PC. Raadpleeg uw netwerkadministrator
voor meer informatie. Zorg ervoor dat de netwerkkaart die u aanschaft
geschikt is voor uw Pocket PC en cofigureer deze met uw Pocket PC.

Een netwerkkaart instellen:

1.

Vraag uw netwerkadministrator om de volgende informatie:
gebruikersnaam, wachtwoord en domeinnaam.

Plaats de netwerkkaart in uw Pocket PC.

Wanneer u de kaart voor de eerste maal plaatst, worden de
netwerkinstellingen automatisch weergegeven, zodat u de netwerkkaart
kunt configureren. Als het niet verschijnt, of als u de instellingen later
wilt wijzigen, tikt u op Il > Settings (Instellingen) > Connections tab
(tabblad Verbindingen) > Network Cards (Netwerkkaarten).

Wanneer u specifieke serverinformatie dient in te voeren, tik dan op de
overeenkomstige adapter, en tik op Properties (Eigenschappen). De
meeste netwerken gebruiken DHCP, dus u hoeft deze instellingen niet
te wijzigen tenzij uw netwerkadministrator u opdraagt dit te doen.

Sluit, indien nodig, de netwerkkaart aan op het netwerk met een
netwerkkabel. Raadpleeg de documentatie die bij uw netwerkkaart
werd geleverd voor meer informatie.

Om een verbinding tot stand te brengen, plaatst u de netwerkkaart

en gebruikt u het gewenste programma. Schakel bijvoorbeeld naar
Pocket Internet Explorer en surf naar een Webpagina. Uw Pocket
PC maakt de verbinding automatisch.

Als u uw netwerkkaart gebruikt met twee netwerken, zoals een privé-
netwerk op uw werk en een thuisnetwerk voor het Internet, dient u het
netwerk waarmee de netwerkkaart een verbinding maakt, aan te passen.

OPMERKING U kunt de instellingen voor de proxyserver en de VPN-
verbinding nodig hebben. Raadpleeg uw
netwerkadministrator voor meer informatie.

Een verbinding beéindigen

Wanneer u verbonden bent via modem of VPN, tik dan in de

navigatiebalk op &* en tik vervolgens op Disconnect (Verbreken).
Wanneer u verbonden bent via kabel of externe slede, koppel dan uw
Pocket PC los van de kabel of van de slede.
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« Wanneer u verbonden bent via infrarood, verplaats dan het apparaat
uit de buurt van de andere computer of het andere apparaat.

+  Wanneer u verbonden bent via een netwerkkaart (Ethernet), verwijder
dan de kaart uit uw Pocket PC.

«  Wanneer u verbonden bent via een draadloos netwerk, schakel dan de
verbinding uit.

Een WAP-gateway instellen

Om toegang te krijgen tot WAP-sites via Pocket Internet Explorer, dient

u uw apparaat in te stellen voor het gebruik van een WAP-gateway. Volg
onderstaande stappen om een nieuwe set verbindingen te maken met het
Internet met WAP-gateway-instellingen.

OPMERKING Sommige apparaatmodellen bieden geen
ondersteuning voor de weergavefunctie van WAP-sites.

1. Vraag de volgende informatie bij uw Internet-provider op:
Telefoonnummer ISP-server, gebruikersnaam en wachtwoord.
Neem ook contact op met de serviceprovider van uw mobiele telefoon
en vraag de naam van de WAP-gatewayserver en het poortnummer.

2. Tik op El > Settings (Instellingen) > Tabblad Connections
(Verbindingen) > Connections (Verbindingen).

3. Tik op Edit my proxy server (Mijn proxyserver bewerken). Als er nog
geen proxyserver werd ingesteld, tik dan op Set up my proxy server
(Mijn proxyserver instellen).

4. Tik op New (Nieuw) onder Programs that automatically connect to
the Internet should connect using (Programma’s die automatisch
een verbinding maken met het Internet en moeten aansluiten met) en
voer een naam in voor de ISP-verbinding.

5. Selecteer op het tabblad Proxy Settings (Proxy-instellingen) de opties
This network uses a proxy server to connect to the Internet (Dit
netwerk gebruikt een proxyserver om een verbinding te maken
met het Internet).

6. Voer, indien nodig, de naam in van de proxyserver in het vak Proxy server.

7. Tik op Advanced (Geavanceerd) > WAP.

8. Geef de Naam WAP-gatewayserver (WAP gateway server name)
op in het vak Server. Voer onder Poort het poortnummer in. Het meest
gebruikelijke WAP-poortnummer is 9201.

9. Geef voor het aanmelden de eventuele identificatiegegevens op die
verseist zijn door de WAP-gatewayserver.

Inbelregels gebruiken

Het is mogelijk dat u, naargelang uw locatie, extra nummers moet kiezen
om een verbinding te maken. Wanneer u bijvoorbeeld van uw werk belt,
moet vaak een prefix worden gekozen, of is een zonenummer nodig.

Een verbinding maken
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Om te verhinderen dat u voor elke situatie een nieuwe modemverbinding
moet maken, kunt u inbelregels instellen voor de locaties waar u vaak een
verbinding maakt. Er werden drie inbellocaties vooraf ingesteld, nl. Home
(Thuis), Mobile (Mobiele telefoon) en Work (Werk). U kunt zelf ook extra
locaties zelf maken. Als er geen verbinding kan worden gemaakt, geeft het
apparaat u de mogelijkheid om de inbellocatie te wijzigen.

1. Tik Ed > Instellingen (Settings) > tabblad Verbindingen
(Connections) > Verbindingen (Connections) > tabblad
Geavanceerd (Advanced) > knop kiesregles (Dialing Rules...).

2. Tik op Use dialing rules (Inbelregels gebruiken).
3. Selecteer een locatie.
+ Home (Thuis) - Belt een nummer als een lokaal gesprek zonder
prefix 9.
« Work (Werk) - Belt het nummer als lokaal gesprek met de prefix 9.
4. Tik op de knop Bewerken (Edit...) en breng de gewenste wijzigingen aan.
5. Tik op OK wanneer u klaar bent.

OPMERKING Tik op Nieuw (New) en volg de richtlijnen op het

scherm om een nieuwe locatie te maken. tik op @ om
op elk ogenblik extra informatie weer te geven.

Terminal Services Client gebruiken
Gebruik Terminal Services Client om aan te melden op een computer en
alle beschikbare programma’s op die computer vanaf uw Pocket PC te
gebruiken. In plaats van Word Mobile uit te voeren, kunt u bijvoorbeeld de
computerversie van Word gebruiken om vanaf uw apparaat toegang te
krijgen tot alle .doc-bestanden op die computer.

Om externe toegang te krijgen tot een computer, moet het programma
Terminal Services of Remote Desktop in Windows 2000 of XP actief zijn.

Om een verbinding te maken met en externe toegang te

hebben tot een computer:

1. Tik op uw Pocket PC om EH > Programma’s (Programs) > Terminal
Services Client.

2. Geef de servernaam op die wordt gebruikt door het programma
Terminal Services of Remote Desktop op de computer.

U kunt de servernaam ook selecteren in de lijst Recente servers als u
reeds vooraf een verbinding hebt gemaakt met een computer.

3. Om een programma van de computer dat specifiek is aangepast voor
gebruik met uw Pocket PC te gebruiken, kunt u de optie Grootte
serverbureaublad aanpassen aan scherm (Limit size of server
desktop to fit on this screen) selecteren om het programma beter
aan te passen aan het scherm van het apparaat.

4. Tik op Verbinden (Connect).
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Navigeren binnen Terminal Services Client

De inhoud van het venster op de computer kan te breed zijn voor het
scherm van uw Pocket PC. U zult mogelijk twee sets schuifbalken zien op
uw apparaat: één om te bladeren door de inhoud van het computervenster
en een voor het bladeren door het scherm Terminal Services Client van uw
apparaat. Om te bladeren door de inhoud van het computervenster, kunt u
de vijf richtingsknoppen onderaan op het scherm Terminal Services Client
gebruiken.

Afmelden van of de verbinding verbreken
met de externe computer

Afmelden zonder de verbinding met de computer te verbreken:

1. Tik in het computervenster op Start > Afsluiten (Shut Down).
Het dialoogvenster Windows afsluiten wordt weergegeven.

2. Tik op <gebruikersnaam> afmelden (Log off <username>) en tik op
ok.

De verbinding verbreken en de externe sessie met de
computer beéindigen:

1. Tik in het computervenster op Start > Afsluiten (Shut Down).
Het dialoogvenster Windows afsluiten wordt weergegeven.
2. Tik op Afsluiten (Shut down) en tik op ok.

Infrarood (IR) verbinding

De straalopties instellen

1. Tik op Bl > Settings (Instellingen) > Connections (Verbindingen).

2. Tik op het pictogram Beam (Verzenden) om het scherm Instellingen
weer te geven.

3. Uw apparaat detecteert standaard binnenkomende infraroodstralen
(IR) en vraagt u ze te aanvaarden. Als u niet wilt dat uw apparaat

stralen detecteert of ontvangt, schakel dan het selectievakje Receive
all incoming beams (Alle binnenkomende stralen ontvangen) uit.
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Infraroodstralen ontvangen

Een bestand ontvangen via infraroodstralen:

1.

Wanneer een ander infrarood apparaat

X , Gegevens ontyangen —
binnen het bereik een bestand of UnAndk aageeing. Mk oo Anvedeson s
gegevens naar u verzendt, ontvangt OO PN N o,
uw apparaat het bestand of de

gegevens en wordt een status van de Verberaed B aneren
gegevensontvangst gevraagd.

Tik na de gegevensoverdracht op Ja (Yes) om te aanvaarden of op
Nee (No) om te weigeren.

OPMERKINGEN Zorg ervoor dat de IR-poorten uitgelijnd zijn op elkaar
zodat ze ongehinderd zijn en binnen het vereiste
bereik liggen. De ontvangen bestanden worden
automatisch opgeslagen in de map Mijn documenten.

Infraroodstralen verzenden
Een bestand via infraroodstralen verzenden:

1.

Tik en houd de pen op een bestand dat
u wilt verzenden en tik vervolgens in het
snelmenu op Beam Files... (Bestand
verzenden...).

Zorg ervoor dat de IR-poorten van de
apparaten één lijn vormen zodat ze
ongehinderd zijn en binnen kort bereik.
Als de poorten niet zijn uitgelijnd, wordt
een bericht weergegeven waarin u
wordt gevraagd dit te doen.

Wanneer een IR-poort is gevonden,
verschijnt een bericht op het scherm dat
het verzendproces aanduidt.

Het bericht Done (Klaar) verschijnt

wanneer de bestandsoverdracht & Rower.pg
voltooid is.

Selecteer apparaal voor wilsiralen
) W_Admiretrat 1 Sereed
.
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Hoofdstuk 8 Bluetooth®

Bluetooth is een draadloze communicatietechnologie met een kort bereik.
Apparaten met Bluetooth-capaciteiten kunnen informatie uitwisselen
zonder dat er enige fysieke verbinding nodig is. In tegenstelling tot
infrarood, hoeft u bij Bluetooth de apparaten niet uit te lijnen om informatie
uit te wisselen. De apparaten moeten alleen binnen een bereik van
ongeveer 10 meter (30 ft) in een open ruimte zijn. U kunt zelfs informatie
doorzenden naar een apparaat in een andere kamer, zolang deze binnen
het opgegeven bereik ligt.

Met de Bluetooth-technologie kan uw Pocket PC:

+ Andere Bluetooth-apparaten in de buurt detecteren

+ De services van deze apparaten ontdekken

+ Een verbinding maken met deze services, ze gebruiken en de
verbinding verbreken

+ Individuele services in- of uitschakelen

+ Beveiligingsfuncties gebruiken zoals verificatie, machtiging en codering

OPMERKING Als u problemen hebt ondervonden bij het gebruik van
Bluetooth® in de weergavestand liggend, schakel dan
naar staand.

Bluetooth gebruiken

Het Bluetooth-pictogram bevindt zich in de
rechterbenedenhoek van het scherm Today
(Vandaag).

Wanneer Bluetooth is ingeschakeld
(ON=AAN), wordt het pictogram blauw & , en
de Bluetooth-LED aan de linkerzijde van het
apparaat knippert blauw.

Wanneer Bluetooth is uitgeschakeld
(OFF=UIT), wordt het pictogram grijs
weergegeven met een rode X in de
rechterbenedenhoek (3. ——— L

Centacten
Wanneer u op het pictogram tikt wordt een
menu weergegeven waarmee u:

Bluetooth-pictogram

+  Bluetooth in- of uit kunt schakelen
+  Bluetooth Manager kunt starten
* Bluetooth-instellingen kunt wijzigen

Bluetooth®

79



80

Bluetooth-instellingen

De Bluetooth-instellingen configureren:

1.

Tik op & > Bluetooth Settings
(Instellingen).

Tik op een van de tabbladen onderaan

in het scherm Settings (Instellingen) om
verschillende instellingen te openen en
te wijzigen.

Algemeen

Hiermee kunt u :

het gebruikersprofiel selecteren
de Bluetooth-status zien (AAN/UIT)
Bluetooth AAN- of UIT zetten

tikken op een koppeling naar de
Bluetooth Manager

Toegankelijkheid

Hiermee kunt u:

Geef een naam op die uw Pocket PC
identificeert als een Bluetooth-apparaat.

Het Bluetooth Device Address (BDA)
zien (apparaatadres Bluetooth)

Geef op of al uw overige Bluetooth-
apparaten of alleen gekoppelde
apparaten een verbinding mogen
maken met uw Pocket PC.

instellen of externe apparaten uw
apparaat kunnen zien

Bluetoath Manager

Bluetooth-instellangen

Conbacten

it Blictoath-inatellin o 45 1001 ok

Ellipet ek b Adgermeen

Huidig prafiel

td:.-:n:l-::ﬂl

[~]&

Bluetooth-status
Bhsetooth stast AAN

I e

Maak verbinding ia de Bustooth Maracer.

N —

i Bluctooth-instelin o 2 1002 ok

¥
et oot Tosegankeljkbend
Apparastidentilicatie
Hoam: [asys
fadres C000 00 O0:00H00
D PrchptPC-a0par st gabusiush voor
Bhetooth

Toegankelijiheid
E Andere spparsten toastasn verkindng te
aken

) ke apparaten
{:I.nleenwude apparsten

] v agparaton lurn mi Farkarren

gumeen | 1omowiziphed -
[
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Services

Onder Bluetooth Services kunt u services zoals Bestandsoverdracht
(File Transfer), Gegevenuitwisseling (Information Exchange), Seriéle
poort (Serial Port), Persoonlijke netwerkserver (Personal Network server)
en Audio Gateway inschakelen/uitschakelen. Tik op een service in de

lijst en selecteer vervolgens of de geselecteerde service moet worden
ingeschakeld en gedeeld met andere apparaten en of er machtigingen en
wachtwoordverificatie nodig zijn tussen de Bluetooth-apparaten.

+ Bestandsoverdracht (File Transfer)
- biedt andere Bluetooth-apparaten

%% Bluetooth-instelling o

de mogelijkheid bestanden op uw :H;: —

Pocket PC te openen en bewerkingen FE T e—— B
uit te voeren die te maken hebben ebpadetad =
met bestanden, zoals het ophalen en B, Pevsonial Network Server B
verwijderen van bestanden, enz. Tik op ~ |Servie-instellingen
Geavanceerd (Advanced) om op uw

apparaat een doelmap in te stellen die

toegankelijk is voor externe apparaten.

Raadpleeg de sectie “Externe =1
apparaatservices” voor meer informatie, ===l LT  sevous [ B |

+ Informatie-uitwisseling (Information
Exchange) - hiermee kunt u een
contactpersoon opgeven die naar
Bluetooth-apparaten wordt verzonden wanneer deze contactpersoon
uw visitekaartje vraagt. Tik op Geavanceerd (Advanced) en tik
vervolgens om een contactpersoon als uw standaard visitekaartje te
kiezen.

+ Seriéle poort (Serial Port)- Geeft de adrestoewijzingen voor de
seriéle poort aan. Tik op Geavanceerd (Advanced) om de adressen
van de huidige seriéle poorten te controleren. Deze adressen kunnen
niet worden gewijzigd. Raadpleeg de sectie “Externe apparaatservices”
voor meer informatie.

« Persoonlijke netwerkserver (Personal Network Server) - hiermee
is hosting van een particulier netwerk op basis van Bluetooth mogelijk.
Raadpleeg de sectie “Externe apparaatservices” voor meer informatie.

+ Audio Gateway - hiermee kan uw Pocket PC een verbinding maken
met een externe headset of een ander audio-apparaat.

Bluetooth®
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Bluetooth Manager

Met de Bluetooth Manager kunt u verschillende typen Bluetooth-
verbindingen vooraf configureren, beheren en gebruiken om een
verbinding te maken met externe apparaten.

De Bluetooth Manager starten:
Tik op B > Bluetooth Manager.

De Bluetooth Manager bevat twee tabbladen:

+ Mijn snelkoppelingen (My Shortcuts) - geeft een lijst weer van
vooraf geconfigureerde verbindingen, als deze er zijn. Tik op Nieuw
(New) om via Bluetooth een nieuwe verbinding te maken met andere
apparaten. Tik en houd de pen op een verbindingspictogram om een
pop-upmenu te openen met verschillende opties voor het verbinden
met apparaten, het verbreken van de verbinding, het controleren van
de verbindingsstatus, en meer.

+ Actieve verbindingen (Active Connections) - geeft actieve
binnenkomende en uitgaande verbindingen weer. Tik op Nieuw
(New) om een nieuwe verbinding te maken. Tik en houd de pen
op een verbindingspictogram om een pop-upmenu te openen met
verschillende opties voor het verbreken van de verbinding met
apparaten en het controleren van de verbindingsstatus.

Bluetooth verbindingswizard
De Bluetooth verbindingswizard helpt u verbindingen tot stand te brengen
met externe Bluetooth-apparaten.

De Bluetooth verbindingswizard starten:

1. Tik in de menubalk van Bluetooth %5 Verbindingswaard @ AE 355
i Ty, Bioctooth- verkennen
Manager op Nieuw (New). Hetl scherm ; st ﬂ%f;gmmm
sl &
van de”BIuetooth verbindingswizard parask enmark siakcpsaligen
verschijnt. High-gualty sudo instellen |
2. Selecteer een verbindingstype dat u tot stand rochmborahars poaten voo
' ?ec . gstyp gebeul et db PocksthC.
wilt brengen. Tik op Volgende (Next). h Internet via de belefoon -
. . L Faadgbeng bt derret
3. Volg de richtlijnen op het scherm om de il teefose, et Bmtooth
verbinding in te stellen. ActiveSync via Siuetooth
Sl phy Ackion Sy varkincineg et
e Blustocth-computer in

OPMERKING Raadpleeg de online help

‘-" Bluetooth-bestandsoverdracht
van het apparaat voor Y otk vatinangmetsanseen . [B

A i

Bluetooth.
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Uitwisseling Visitekaart

Met de functie Visitekaartje uitwisselen (Business Card Exchange) kunt u
een visitekaartje verzenden naar of ontvangen van een extern apparaat of
visitekaartjes uitwisselen met meerdere externe apparaten.

Visitekaartje uitwisselen (Business Card Exchange) openen:

1. Tik in de menubalk op Menu >
Visitekaartje uitwisselen (Business

g Vistckoarties Wtwe e

Bhuetooth
Card Exchange). Visk ek amtjes utvissben
2. S.electeer de bewerking die u wilt ., Ve st
| ¥ Bhstondh rihr dan of reeer
uitvoeren. il
OPMERKING Tik in dit scherm op de [ Wil vickukaartios & mat nan

=i (== of meer personen via Blustooth

koppeling Selecter het
visitekaartje (Select the Ve e bRt} s
business card) om naarde | *B= Y it
instellingen voor Gegevens '

uitwisselen (Information
Exchange) te gaan.

Seiecteer bet vishekaartis dat o wikt verzenden
of nysben,

Services externe apparaten

Draadloze seriéle poort

Wanneer u een Bluetooth seriéle poort gebruikt is dit equivalent met het
gebruik van een fysieke kabelverbinding via de seriéle poort tussen twee
apparaten. Net als bij de fysieke aansluiting, dient u de toepassing te
configureren die de seriéle poort zal gebruiken.

De Bluetooth seriéle poort instellen:

1. Tik op & > Bluetooth Settings (Instellingen) > Serial Port (Seriéle
poort).

2. Selecteer Seriéle poort... (Serial Port...) in de lijst Services.

3. Tik op Geavanceerd (Advanced). Noteer de toegewezen uitgaande COM-

poort (poort 8) en configureer de toepassing die de seriéle Bluetooth-poort
zal gebruiken om gegevens naar deze poort te verzenden.

OPMERKING Raadpleeg de documentatie van de toepassing voor meer
informatie over het configureren van de uitgaande COM-
poort van uw toepassing.

4. Open de seriéle poortaansluiting van de Bluetooth op het externe
apparaat, op het scherm My Shortcuts (Mijn Snelkoppelingen).

5. Verzend/ontvang gegevens naar/van de toepassing.

Bluetooth®
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Inbelnetwerk

Met de functie Inbelnetwerk (Dial-up Networking feature) kunt u uw Pocket PC
via een telefoonlijn verbinden met een Bluetooth-apparaat. Wanneer u een
verbinding heeft, kunt u surfen op het Internet, e-mails controleren/lezen, enz.
Het Bluetooth-apparaat dat de inbelnetwerkservice aan uw Pocket PC
zal leveren, moet toegang hebben tot een telefoonsysteem. Dit kan een
bekabelde of draadloze verbinding zijn en deze moet in staat zijn een oproep
te beantwoorden. Een dergelijk apparaat kan een mobiele telefoon met
Bluetooth-ondersteuning, een desktopcomputer met Bluetooth-ondersteuning
die op een telefoonsysteem is aangesloten of een Bluetooth-modem zijn.

Apparaten die de service voor een inbelnetwerk kunnen bieden:

+ Mobiele telefoons met geactiveerde Bluetooth

+  Computer met geactiveerde Bluetooth, verbonden met een telefoonsysteem
+  Bluetooth-modem

Het inbelnetwerk gebruiken:

1. Tikop B > Bluetooth Manager.
2. Maak een verbinding met het apparaat dat de telefoontoegang zal
bieden. Zie de sectie “Bluetooth verbindingswizard”.

3. Tik en houd de pen om de nieuwe snelkoppeling in het scherm Mijn
snelkoppelingen (My shortcuts) en selecteer vervolgens Verbinden
(Connect) in het pop-upmenu.

4. Dubbeltik op het eerste scherm van de Bluetooth-verbinding op
Nieuwe verbinding... (New Connection...).

5. Geef in het tweede scherm voor de Bluetooth-verbinding een naam
op voor de verbinding, een telefoonnummer voor het inbellen en de
overige gevraagde informatie. Tik vervolgens op ok.

6. Geef de vereiste informatie op in de opeenvolgende schermen.

Bestandsverkenner

De Bestandsverkenner verschijnt automatisch nadat een verbinding voor

bestandsoverdracht is gemaakt.

Met deze servicefunctie kunt u de volgende bewerkingen uitvoeren:

+ Navigeren door de mapstructuur van het externe apparaat

+ De bestanden en mappen weergeven op het externe apparaat

+ Nieuwe mappen maken op het externe apparaat

+ Bestanden verzenden naar en kopiéren of ophalen van het externe
apparaat

+ Bestanden van het externe apparaat verwijderen

OPMERKING De bestandsbewerkingen op het externe apparaat zijn

beperkt tot de geconfigureerde FTP-hoofdmap en
submappen van het externe apparaat.
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Met de Bluetooth bestandsverkenner kunt u ook een map in uw Pocket PC
instellen voor het ontvangen van inkomende bestanden. U kunt deze map
configureren voor elke snelkoppeling voor uw verbindingen. Zie sectie
“Een lokale map instellen”.

Menu’s van Bluetooth File Explorer (Bestandsverkenner)
File (Bestand) == Send a File (Een bestand verzenden...)
Create a Folder (Een map maken)
Get (Ophalen)
Delete (Verwijderen)

Tools (Extra) == Set Local Folder (Lokale map instellen)
Refresh (Vernieuwen)

De map van het externe apparaat wijzigen:

1. Om u omlaag te verplaatsen in de mapstructuur van het externe
apparaat, tikt u op New Folder (Nieuwe map) in het hoofdvenster van
de Bestandsverkenner.

2. Om u omhoog te verplaatsen in de mapstructuur van het externe
apparaat, tikt u op de pijl omlaag, rechts van de momenteel geselecteerde
map en selecteert u New Folder (Nieuwe map) in de vervolgkeuzelijst.

Een map maken op het externe apparaat:

1. Selecteer de map waarin u de nieuwe map wilt plaatsen.

2. Tik in het menu File (Bestand) op Create a Folder (Map maken).

3. Voer een naam in voor de nieuwe map terwijl de standaardnaam New
Folder (Nieuwe map) gemarkeerd is.

Een bestand verzenden naar een extern apparaat:
1. Tik in het menu File (Bestand) op Send a File... (Een bestand
verzenden...) om het scherm Openen weer te geven.
Het scherm Openen bevat het volgende:
Folder (Map) - tik op de pijl omlaag en selecteer de map die het
bestand bevat dat u wilt verzenden
Type - standaard en enige optie is “Alle bestanden (*.*)”
Alist of files in the selected folder (Een lijst bestanden in de
geselecteerde map) - tik op een bestand dat u wilt verzenden
Cancel button (Annuleren) - het verzenden van een bestand afbreken
2. Tik op de gewenste bewerking.
Het geselecteerde bestand wordt automatisch verzonden wanneer u
erop tikt. Daarna verschijnt de Bluetooth bestandsverkenner weer.
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Een bestand van een extern apparaat halen:

1. Selecteer de map die het bestand bevat.

2. Tik op het bestand dat u wilt ophalen of kopiéren.

3. Tik in het menu File (Bestand) op Get (Ophalen).
OF
Tik en houd de pen op het gewenste bestand en selecteer Get
(Ophalen) in het pop-upmenu.
Het bestand wordt gekopieerd naar de lokale map die in het
gelijknamige veld onderaan op het scherm wordt weergegeven.

Een bestand verwijderen van een extern apparaat:

1. Tik op het bestand dat u wilt verwijderen.

2. Tik in het menu File (Bestand) op Delete (Verwijderen).

3. Tik op ok in het dialoogvenster dat om uw bevestiging vraagt.
OF
Tik en houd de pen op het gewenste bestand en selecteer Delete
(Verwijderen) in het pop-upmenu.

Een lokale map instellen voor inkomende bestanden:

1. Tik in het menu Extra op Set Local Folder (Lokale map instellen).

2. Gebruik het vervolgkeuzemenu bovenaan op het scherm om naar de
gewenste map te gaan.

3. Tik op ok om terug te keren naar het hoofdscherm van de Bluetooth
bestandsverkenner. U zult zien dat het veld Local Folder (Lokale Map)
werd bijgewerkt en de nieuwe mapselectie weergeeft.

OPMERKING De informatie van de lokale map is gekoppeld aan de
momenteel geopende snelkoppeling en wordt opgeslagen
met het actieve profiel. U kunt uw lokale map afzonderlijk
configureren voor elke snelkoppeling voor de verbinding.

Om de lijst van de weergegeven bestanden en mappen op het

externe apparaat te vernieuwen, tikt u in het menu Extra op Refresh
(Vernieuwen).
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Verzenden via Bluetooth

Via Bluetooth kunt u op een eenvoudige manier uw Contacten van Pocket
Outlook, agenda-items en taken afzonderlijk of gezamenlijk verzenden
naar het externe apparaat.

Gegevens verzenden via Bluetooth:

1. Tik op E en vervolgens op Contacts
(Contacten), Calendar (Agenda), of
Tasks (Taken). [ o |

2. Tik en houd de pen op het item dat
u naar het externe apparaat wilt
verzenden en tik vervolgens op

rm Adeen

E-mail werzeniden
Bellen via Bluctooth

Verzenden via Bluctooth

Verzenden via Bluetooth (Send via Tk vieende ¥
Bluetooth) in het pop-upmenu. T ‘"*"E":'

ool sl versjderen
OF

Tik op Menu > Verzenden via
Bluetooth (Send via Bluetooth).
3. Tik in het scherm voor het selecteren

van een Bluetooth-apparaat op de e el

naam van de bestemming en tik op ok.

Bellen via Bluetooth

Met de optie Dial via Bluetooth (Bellen via Bluetooth) kunt u een
contactpersoon selecteren in de lijst van Contacten van Pocket Outlook en
uw gekoppelde telefoon het telefoonnummer van de contactpersoon laten
kiezen. Als een contactpersoon meerdere telefoonnummers heeft, selecteer
dan het nummer dat u wilt bellen. U kunt ook een telefoonnummer wijzigen
voordat u belt.

Bellen via Bluetooth:

1. Tik en houd de pen op een contactpersoon in het scherm Contacten
(Contacts) en selecteer Kiezen via Bluetooth (Dial via Bluetooth).

2. Als uw Pocket PC gekoppeld is aan meerdere mobiele telefoons,
of als er nog geen telefoon werd geselecteerd, tik dan op het
telefoonpictogramma naast Select a phone (Selecteer een telefoon),
en selecteer de telefoon die u wilt gebruiken.

3. Selecteer het nummer dat u wilt bellen en tik vervolgens op Dial
Number (Nummer kiezen).
Nadat het nummer naar de mobiele telefoon is verzonden, wordt de
verbinding met het apparaat gesloten.
Nadat de mobiele telefoon het inbelproces heeft doorlopen, kunt u de
telefoon op de normale manier gebruiken.

Bluetooth®
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Bluetooth Persoonlijk Netwerk

Een Bluetooth persoonlijk netwerk is een privé-, tijdelijk, ad-hoc netwerk
van maximaal acht apparaten. Met een Bluetooth persoonlijk netwerk kunt
u gemakkelijk informatie uitwisselen, die normaal een TCP/IP-netwerk
vereist. De meeste chatprogramma’s, multi-player games, enz. zijn
volledig functioneel in een persoonlijke Bluetooth-netwerkomgeving.

Bluetooth persoonlijke netwerken zijn onderhevig aan dezelfde
beveiligingsinstellingen (servicebeschikbaarheid, machtiging, verificatie en
codering) als andere Bluetooth-communicaties.

Eén Bluetooth-apparaat moet de host zijn van een persoonlijk netwerk.
Andere Bluetooth-apparaten kunnen deelnemen aan het netwerk als
clients. De host kan clients op individuele basis aanvaarden of weigeren.

Een Bluetooth persoonlijk netwerk instellen:

1. Tik in de Bluetooth Manager op Nieuw

(New) > Bluetooth Personal Network. Eduetooth Verbindingswmzard
Bhastostd Perional Kbk
2. Selecteer Als host voor een Personal P
Network optreden (Host a personal G oo Pl o o sk ok
i i () Werbincen wan Personsl MNetweork:
net\(vork) in het scherm van de wizard, D:Mw o s il tolue
en tik op Volgende (Next). mrhewnl wan sen ander
3. Voeg externe apparaten toe aan een ) 5 st woor e, Prrsaral Nekward
. . . ioptreden: Breng een Personal
Bluetooth persoonlijke netwerk, indien u Network 1o tanc vt e e
AP AH.
dat wenst. Thcs Yok o o oo Ths
a. Tik op de knop Toevoegen (Add) en | “mi onde s i Suten
selecteer het apparaat dat u wilt it S el il
toevoegen. [ ]

b. Voeg andere apparaten toe, indien
u dat wenst. U kunt maximaal acht apparaten, inclusief de host
aansluiten.
4. Tik op ok nadat u de apparaten heeft toegevoegd om de setup te
voltooien en de wizard te sluiten.

OPMERKING Het toevoegen van apparaten gebeurt optioneel. U
dient geen apparaten toe te voegen aan het persoonlijk
netwerk tijdens het configureren van de host. U kunt ze
op een later tijdstip laten deelnemen aan het persoonlijk
netwerk.

Hoofdstuk 8



Deelnemen aan een persoonlijk netwerk:

1.

Tik in de Bluetooth Manager op Nieuw

(New) > Bluetooth Personal Network. ey
Selecteer Verbinden met een Personal ek e
Nerwork (Join a personal network) in | i e 2o v vertndog o maben

ek een Personal Msbwork of als host

i i B0 vk optreddan
het wizardscherm en tik op Volgende B
(Next). Wﬁhﬂ'ﬂnttmw
P Fbweork van een
Selecteer de host van het persoonlijk  anmme
netwerk en tik op Next (Volgende) ottt et
om een verbinding te maken met het Tk i

persoonlijk netwerk.

Als de IP-netwerkinstellingen worden
gevraagd, selecteer dan Server- | Amaeren $Yorige Velgende

toegewezenIP-adresgebruikenentikopok. I S

Th op Volgende' o door be gaan. Tk op
‘lirrw e’ om dis wizand of be shulten

Audio met hoge kwaliteit of HANDS-
FREE/headset instellen

1.
2.

Tik op het pictogram & > Bluetooth Manager.

Tik op Nieuw (New) > High-quality audio instellen (High Quality
Audio setup) of Instelling HANDS-FREE/Headset (Hands-free/
Headset setup) > Volgende (Next).

Volg de instructies op het scherm om de instelling te voltooien.

Opmerking  Controleer of het HANDS-FREE apparaat waarmee u een verbinding
probeert te maken, klaar is om binnenkomen verbindingsaanvragen
te ontvangen. Raadpleeg de handleiding van het apparaat voor meer
informatie.

ActiveSync via Bluetooth instellen

1.
2.
3.

5.

6.

Tik op het pictogram & > Bluetooth Manager.

Tik op Nieuw (New) > ActiveSync via Bluetooth > Volgende (Next).
Volg de instructies op het scherm om de instelling te voltooien.
Controleer of het nummer van de COM-poort dat in het programma
ActiveSync op de computer is ingesteld, hetzelfde is als de COM-
poortinstelling op MyPal.

Selecteer in het scherm Wizard Bluetooth-verbinding (Bluetooth

Connection Wizard) de naam van de computer die met MyPal moet
worden gesynchroniseerd en tik vervolgens op Volgende (Next).

Selecteer de COM-poortinstelling die door de computer wordt gebruikt
en tik op Volgende (Next).

Tik op Voltooien (Finish).

Bluetooth®
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Hoofdstuk 9 Wi-Fi

MyPal A639 wordt geleverd met een ingebouwde Wireless Fidelity (WiFi®)-
functie waarmee u een verbinding kunt maken met draadloze LAN-netwerken
en het Internet. MyPal A639 maakt gebruik van de IEEE 802.11b/g standaard
voor draadloos LAN en kan verbindingen tot stand brengen aan snelheden
tot 17 Mbps met een toegangspunt (Infrastructuurmodus) of met een ander

draadloos apparaat (Ad-hoc-modus).

WiFi-functie gebruiken

Het WiFi-pictogram op uw scherm Today
(Vandaag) biedt u gemakkelijk toegang tot de
WiFi-functie (Wireless Fidelity) op uw apparaat.
Als u tikt op het pictogram, wordt een menu
weergegeven waarmee u:

*  het Wi-Fi in of uit kunt schakelen
+ De WiFi-instellingen kunt configureren

OPMERKING U kunt de Bluetooth®-
en WiFi-functies
tegelijk gebruiken.

WiFi-functie inschakelen
WiFi-functie inschakelen:

1. Tap

De PocketPCzoektvervolgens automatisch
naar alle beschikbare draadloze
netwerken binnen het WiFi-bereik.

2. Selecteer een draadloos netwerk
waarmee u uw apparaat wilt verbinden,
in de lijst van gedetecteerde draadloze
netwerken.

3. Selecteer of het draadloos network
een verbinding moet maken met het
Internet (of werken via een VPN) of
Werk (Work network).

4. Tik op Verbinden. Het apparaat wordt
verbonden met het geselecteerde
netwerk.

WiFi® gebruiken

Ll > WiFi inschakelen (Enable Wi-Fi).

s Stat

§ donderdan
26 juli 20607

0

helen exgerar erardin

Cankactiin

Pictogram draadloos LAN

e Start

donderdag
26 juli 20607

. iZeen sarstasnds of spraken

Selectaar b be Gebra reltverk:
EM [bet betrwredied]

() MY [Pest Eviige]

() WLAN_AP [Beveiigng ingeschakeld]
&g netearken vesraseen
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Draadloze netwerken configureren

Een draadloos netwerk configureren:

1. Nadat u een netwerk hebt geselecteerd waarmee u uw apparaat wilt
verbinden, tikt u op Instellingen in plaats van op Verbinden.

2. Tik op Netwerkkaarten (Network Cards) > tabblad Draadloos
(Wireless).

3. Tik in het scherm Draadloze netwerken configureren (Configure
Wireless Networks) om een beschikbaar draadloos LAN en breng
vervolgens de gewenste wijzigingen aan, zoals nodig.

Als het draadloos LAN waarmee u een verbinding wilt maken, niet

in de lijst voorkomt, tik dan op Nieuw toevoegen... Raadpleeg de
hiernavolgende secties voor details over de manier waarop u nieuwe
draadloze LAN’s kunt toevoegen.

4. Tik op ok wanneer u klaar bent.

Een netwerkadapter configureren:

1. Tik op het tabblad Netwerkadapters.

2. Voer de gewenste wijzigingen uit op de beschikbare adapters in de
lijst.

3. Tik op ok wanneer u klaar bent.

4. Nadat u de instellingen voor de netwerkadapter hebt gewijzigd,
verschijnt een bericht dat u vraagt de netwerkkaart te verwijderen en
vervolgens opnieuw te installeren zodat uw wijzigingen van kracht
worden. Tik op ok om het venster te sluiten.

Een draadloos netwerk toevoegen

Als het apparaat het draadloos netwerk waarmee u een verbinding
wilt maken niet automatisch detecteert, kunt u het netwerk toevoegen
op voorwaarde dat u de instellingen van het draadloze netwerk kent.
U kunt de instellingen voor het draadloze netwerk aanvragen bij uw
netwerkbeheerder voordat u verder gaat.

Een draadloos netwerk toevoegen:

1. Open het venster Draadloze netwerken configureren als volgt:

. Tik op Instellingen in de toelichting Meerdere netwerken
gedetecteerd.

OF
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. Tik op B > Instellingen (Settings) > tabblad Verbindingen
(Connections) > Netwerkkaarten (Network Cards).

Braadloze nebwerken configeireren ﬂ

Ter gl ratrembers

|.=-IL- beschibano -l

o st | Netwerbadaptars |

. Tik op het tabblad Draadloos (Wireless) van het scherm Draadloze
netwerken configureren (Configure Wireless Networks) op Nieuw
toevoegen (Add New).

. Gebruik het invoerpaneel om de Netwerknaam (Network name) in te
voeren op het tabblad Algemeen (General) van het scherm Draadloos
netwerk configureren (Configure Wireless Network).

Selecteer vervolgens of het draadloos network een verbinding moet maken
met het Internet-netwerk of het Werk-netwerk (Work network).

Als u een ander draadloos apparaat wilt verbinden (Ad-hoc-modus),
activeer dan de optie Dit is een apparaat-naar-apparaat-verbinding
(ad-hoc).

Tik anders op het tabblad Netwerksleutel om de
beveiligingsinstellingen van het LAN-netwerk te configureren.

. Selecteer de instellingen Verificatie en Gegevenscodering op het
tabblad Netwerksleutel van het draadloos LAN dat u wilt toevoegen.

OPMERKINGEN Vraag uw netwerkbeheerder naar de
beveiligingsinstellingen voor het netwerk.

. Tik op het tabblad 802.1x om andere netwerkbeveiligingsinstellingen te
configureren.

. Tik anders op ok om het draadloos netwerk toe te voegen.

Het nieuwe draadloze netwerk wordt vervolgens toegevoegd aan de
lijst onder het tabblad Draadloos (Wireless).

. Tik en houd de pen op het nieuwe draadloze netwerk in de lijst en

tik vervolgens in het pop-upmenu op Verbinden (Connect) om uw
apparaat te verbinden met dat netwerk.

WiFi® gebruiken
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De Wi-Fi Manager

De Wi-Fi Manager toont de verbindingsstatus van en informatie over een
draadloos network en biedt u de mogelijkheid handmatig beschikbare
draadloze netwerken te zoeken in uw gebied.

Wi-Fi Manager openen:

« Tikop B > WLAN-instelling (WLAN Setting). Of,

« Tik op > Instellingen (Settings) > tabblad Verbindingen
(Connections) > Wi-Fi Manager.

De Wi-Fi Manager bevat twee tabbladen:

Wi-Fi Status

Dit tabblad geeft aan of de WiFi momenteel is aangesloten en toont informatie over
de draadloze verbinding. De volgende specifieke informatie wordt weergegeven:

Status

Dit veld toont de status van de WiFi-verbinding.

+ Verbonden - het station is verbonden met één draadloos LAN-
apparaat. Deze status geeft ook het MAC-adres van het apparaat aan.

+ Verbinding verbroken - er bestond een eerdere verbinding, maar
er werd geen baken ontvangen. De verbinding met de adapter wordt
beéindigd.

ESSID

Dit veld toont de Extended Service Set Identifier (ESSID) waarmee het
draadloos apparaat is verbonden. De tekst in dit veld is doorgaans een
onleesbare alfanumerieke tekenreeks.

BSSID

Dit veld toont de Basic Service Set ID (BSSID) waarmee het draadloos
apparaat is verbonden. In de ESS-modus, is dit het MAC-adres van het
toegangspunt waarmee uw apparaat een verbinding heeft.

BSS-modus

Dit veld laat u weten of het apparaat verbonden is met een toegangspunt
(Infrastructuurmodus) of met een ander draadloos apparaat (Ad-hoc-modus).

Signaalsterkte

Dit veld toont het niveau van de signaalsterkte tussen het WiFi-apparaat
en het toegangspunt (of een ander draadloos apparaat) waarmee het
momenteel verbonden is.
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Instelling (Setting)

B T Op dit tabblad kunt u de instellingen

W Fi-Beheerder

Adhoc-kana lﬁ
. (5]
Ererpetesparng: [ngeschakedd __+]
Erwrgesterkte: [S0% -

Butomatisch
it hioper: itgeschaleld

Instellen

and | Irateling ﬂ'ﬂnlﬁm.-q L

IP Info

OPMERKING

& definiéren voor het maken van een draadloze
verbinding van apparaat naar apparaat te
maken en voor de energiebesparing.

Wij raden u aan
Energiebesparing in te
stellen op Inschakelen.

Op dit tabblad wordt de Internet Protocol (IP)-informatie van het apparaat
weergegeven, inclusief de hostnaam, de DNS-server, het IP-adres, enz.

Op dit tabblad kunt u het IP-adres vernieuwen wanneer het draadloos
netwerk gebruik maakt van DHCP (Dynamic Host Configuration Protocol).
Wanneer u tikt op de knop IP Vernieuwen (Renew) zal het apparaat

zijn door de server toegewezen IP-adres geforceerd vernieuwen. Het
proces kan meerdere seconden duren terwijl het systeem de IP-informatie

bijwerkt.

U kunt het draadloos apparaat dat momenteel op het draadloos netwerk is
aangesloten ook proberen te detecteren door op de knop Ping te tikken.

Site-overzicht

Met dit tabblad kunt u zoeken naar
beschikbare draadloze netwerken binnen
uw locatie. Tik op de knop Herscannen om
te zoeken naar alle beschikbare draadloze
netwerken en om de resultaten op het

scherm weer te geven.

Elk draadloos netwerk wordt voorafgegaan
door een pictogram voor een gemakkelijke
identificatie. Het netwerkkanaal, RSSI

en BSSID worden ook weergegeven in

kolommen.

WiFi® gebruiken
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Raadpleeg de onderstaande tabel met pictogramaanwijzingen en
kolombeschrijvingen.

Tabel met pictogramaanwijzingen

Pictogram Duidt aan dat het draadloze netwerk

&) een toegangspunt is met uitgeschakelde WEP-codering (Wired Equivalent
Privacy)

&l  eentoegangspunt is met ingeschakelde WEP-codering

%:l een toegangspunt is met uitgeschakelde WEP-codering en dat MyPal
’ momenteel verbonden is met dit netwerk

%{ een toegangspunt is met ingeschakelde WEP-codering en dat MyPal
; momenteel verbonden is met dit netwerk

@ een draadloos apparaat is met uitgeschakelde WEP-codering

LS,?E een draadloos apparaat is met ingeschakelde WEP-codering

@ een draadloos apparaat is met uitgeschakelde WEP-codering en dat MyPal
momenteel verbonden is met dit netwerk

@g een draadloos apparaat is met ingeschakelde WEP-codering en dat MyPal
momenteel verbonden is met dit netwerk

ESSID
Deze kolom toont Extended Service Set Identifier (ESSID) van het
draadloos netwerk dat in de zoekopdracht is gevonden.

CH

Deze kolom toont het kanaal dat door het draadloze apparaat wordt gebruikt.
RSSI

Deze kolom toont de Received Signal
Strength Indication (RSSI) die wordt 'r'-'li Uitstekend
uitgezonden door elk draadloos netwerk. P Goed

Deze informatie is nuttig om te bepalen =

welk netwerk u wilt koppelen aan uw J Redelijk

apparaat. Dit signaal wordt normaal ; Zwak

voorgesteld door een dBm-waarde.

OPMERKING Het pictogram kan groen of oranje zijn. Het groene
pictogram geeft aan dat het signaal is ontvangen van
een |EEE 802.11b-apparaat, terwijl het oranje pictogram
aangeeft dat het signaal is ontvangen van een IEEE
802.11g-apparaat.

BSSID
Deze kolom toont het MAC-adres (Media Access Control) van het
toegangspunt of het Basic Service Set ID (BSSID) in een ad-hoc-modus.

Hoofdstuk 9



Bijlage Bepalingen

Verklaring van de Federale Communicatie
Commissie

Dit apparaat voldoet aan Deel 15 van de FCC-voorschriften. Het gebruik is onderhevig aan
de volgende twee voorwaarden:

+ Dit apparaat mag geen schadelijke storingen veroorzaken, en

+  Dit apparaat moet elke ontvangen storing aanvaarden, inclusief storingen die een
ongewenste werking kunnen veroorzaken.

Dit apparaat is getest en voldoet aan de beperkingen van een Klasse B digitaal apparaat,
conform met Deel 15 van de FCC-voorschriften. Deze beperkingen zijn ontworpen om een
redelijke bescherming te vormen tegen schadelijke storingen wanneer het apparaat wordt
gebruikt in een woonomgeving. Dit apparaat genereert, gebruikt en kan radiofrequente
energie uitstralen. Indien het niet wordt geinstalleerd en gebruikt in overeenstemming met de
voorschriften, kan het schadelijke storingen in radiocommunicatie veroorzaken. Er is echter
geen garantie dat er zich geen storingen zullen voordoen in een specifieke installatie. Indien
dit apparaat toch schadelijke storingen veroorzaakt in de radio- of televisieontvangst, wat kan
worden bepaald door het apparaat uit en in te schakelen, raden wij u aan de storing op te
lossen met een van de volgende maatregelen:

Verplaats de ontvangstantenne of wijzig de richting.
+ Vergroot de afstand tussen het apparaat en de ontvanger.

+  Sluit het apparaat aan op een ander stopcontact dan dat waarop de ontvanger is
aangesloten.

Vraag hulp aan uw verkoper of een ervaren radio- of TV-technicus.

OPGELET! Het gebruik van afgeschermde kabels voor de aansluiting
van het beeldscherm op de grafische kaart is vereist om
de conformiteit met de FCC-voorschriften te verzekeren.
Wijzigingen of aanpassingen aan dit apparaat die
niet uitdrukkelijk werden goedgekeurd door de partij,
verantwoordelijk voor de conformiteit, kan de bevoegdheid
van de gebruiker voor het gebruik van dit apparaat nietig
verklaren.

Verklaring Canadees Communicatiedepartement

Dit digitale apparaat is niet in overtreding van de Klasse B-beperkingen voor emissie
van radioruis van digitale apparaten zoals is vastgesteld in de reglementering betreffende
radiostoringen van het Canadese Communicatiedepartement.

Dit klasse B digitale apparaat is conform met de Canadese richtlijn ICES-003.

Bepalingen
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UL Veiligheidsrichtlijnen

Vereist voor UL-1459 met betrekking tot telecommunicatie-uitrustingen (telefoon), bedoeld om
elektrisch te worden aangesloten op een telecommunicatienetwerk met een werkspanning naar
aarde die niet hoger is dan een piekspanning van 200V en 300V en 105V rms, en die wordt
geinstalleerd of gebruikt in overeenstemming met de Nationale Elektrische Code (NFPA 70).

Wanneer u de Pocket-PC gebruikt, moeten bepaalde standaard veiligheidsmaatregelen
worden nageleefd om het risico op vuur, elektrische schokken en persoonlijke letsels te
voorkomen, inclusief de volgende voorschriften:

Gebruik de Pocket-PC niet in de buurt van water, bijvoorbeeld bij een badkuip, een
wasbak, een gootsteen of een waskuip, in een vochtige kelder of bij een zwembad.
Gebruik de Pocket-PC niet tijdens een onweer. Er bestaat een beperkt risico op
elektrische schokken door blikseminslag.
Gebruik de Pocket-PC niet in de nabijheid van een gaslek.
Vereist voor UL-1642 met betrekking tot primaire (niet herlaadbare) en secundaire
(herlaadbare) lithiumbatterijen die als voedingsbron voor de producten worden gebruikt.
Deze batterijen bevatten metaal lithium, of een legering van lithium, of een lithium ion, en kan
serieel of parallel, of op beide manieren, één elektrochemische cel of twee of meer cellen
bevatten, die chemische energie omzetten naar elektrische energie door een onomkeerbare
of omkeerbare chemische reactie.
Gooi het batterijpakket van de Pocket-PC niet in het vuur, aangezien het kan ontploffen.
Controleer de lokale voorschriften op mogelijke speciale richtlijnen voor het wegwerpen,
om het risico op persoonlijk letsel ten gevolge van brand of ontploffing te voorkomen.
Gebruik geen voedingsadapters of batterijen van andere apparaten. Hierdoor voorkomt
u risico op persoonlijke letsels ten gevolge van brand of ontploffing. Gebruik alleen UL-
goedgekeurde voedingsadapters of batterijen, geleverd door de fabrikant of erkende
verdelers.

Vervangbare batterijen

Als een apparaat wordt geleverd met een vervangbare batterij en indien het vervangen
van de batterij door een verkeerd type kan leiden tot een ontploffing (bv. met sommige
lithiumbatterijen), is het volgende van toepassing:

— Als de batterij wordt geplaatst in een GEBIED TOEGANKELIJK VOOR DE
OPERATOR, zal er dichtbij de batterij een markering voorzien zijn, of een vermelding
in de bedienings- en onderhoudsrichtlijnen;

— Als de batterij op een andere plaats in het apparaat wordt geplaatst, zal er dichtbij de
batterij een markering voorzien zijn of een vermelding in de onderhoudsrichtlijnen.

De markering of vermelding zal de volgende tekst of een gelijkaardige tekst bevatten:

WAARSCHUWING
RISICO OP ONTPLOFFING INDIEN BATTERIJ WORDT
VERVANGEN DOOR EEN VERKEERD TYPE.
WERP DE GEBRUIKTE BATTERIJEN WEG

IN OVEREENSTEMMING MET DE RICHTLIJNEN
Naleving wordt gecontroleerd door inspectie.

Operatortoegang met een gereedschap

Als een GEREEDSCHAP nodig is om toegang te krijgen tot een GEBIED TOEGANKELIJK
VOOR DE OPERATOR, zullen alle andere delen binnen dit gebied, die een gevaar
betekenen, niet toegankelijk zijn voor de OPERATOR met hetzelfde GEREEDSCHAP, of zullen
dergelijke delen worden gemarkeerd om de OPERATOR te weerhouden van de toegang.

Een aanvaardbare markering voor gevaar op elektrische schokken is A\ (ISO 3864, No. 5036)

Uitrusting voor locaties met beperkte toegang

Voor uitrusting die uitsluitend bedoeld is voor installatie in een LOCATIE MET BEPERKTE
TOEGANG, zullen de installatierichtlijnen hierover een bepaling bevatten.

Bijlage



Controlelijst van Regelgevende verklaringen

15.21

Hierbij waarschuwen wij u dat elke wijziging of aanpassing aan deze handleiding die
niet uitdrukkelijk is toegestaan, uw recht om het apparaat te gebruiken, kan
vernietigen.

WAARSCHUWING: Alle wijzigingen of aanpassingen die niet uitdrukkelijk zijn goedgekeurd
door de partij die verantwoordelijk is voor de naleving, kunnen de bevoegdheid van de

gebruiker om het apparaat te bedienen nietig verklaren.

Verbod op co-locatie
Dit apparaat mag niet worden geplaatst of gebruikt in combinatie met een andere antenne of zender

15.105 FCC-voorschriften (Federal Communications Commission), Deel 15

Dit apparaat werd getest en voldoet aan de beperkingen voor een klasse B digitaal apparaat,
in naleving van deel 15 van de FCC-voorschriften. Deze limieten zijn vastgesteld om een
redelijke beveiliging te bieden tegen schadelijke storingen in een residentiéle installatie.

Deze apparatuur genereert, gebruikt en straalt radiofrequente energie uit die, indien niet
geinstalleerd en gebruikt in overeenstemming met de instructies, schadelijke storingen

kan veroorzaken aan radiocommunicaties. Er is echter geen garantie dat er geen storing
zal optreden in een particuliere installatie. Indien dit apparaat toch schadelijke storingen
veroorzaakt aan radio- of televisieontvangst, wat kan vastgesteld worden door het apparaat
in en uit te schakelen, moet de gebruiker deze storing proberen te corrigeren door een of
meer van de volgende maatregelen te nemen:

—Wijzig de richting van de ontvangstantenne of verplaats de antenne.

—Vergroot de afstand tussen de apparatuur en de ontvanger.

—Sluit het apparaat aan op een stopcontact op een ander circuit dan dat waarop de
ontvanger is aangesloten.

—Raadpleeg de leverancier of een ervaren radio/Tv-technicus voor hulp.

Regelgevende informatie / Disclaimers

De installatie en het gebruik van dit draadloze LAN-apparaat moet in strikte
overeenstemming zijn met de instructies die worden vermeld in de gebruikersdocumentatie
die bij het product is geleverd. Alle aanpassingen of wijzigingen (inclusief aan de antennes)
die aan het apparaat zijn aangebracht en niet uitdrukkelijk zijn goedgekeurd door de fabrikant
kunnen de bevoegdheid van de gebruiker om het apparaat te bedienen, annuleren. De
fabrikant is niet verantwoordelijk voor enige radio- of televisiestoring die is veroorzaakt door
niet toegelaten wijzigingen aan dit apparaat of door het vervangen van de aansluitingskabels
en uitrusting die niet overeenstemmen met de opgegeven specificaties van de fabrikant. Het
is de verantwoordelijkheid van de gebruiker om elke storing die dergelijke niet toegelaten
wijziging, vervanging of uitbreiding heeft veroorzaakt, te corrigeren. De fabrikant en zijn
erkende wederverkopers of verdelers zullen geen aansprakelijkheid aanvaarden voor enig
schade of overtreding van overheidsreglementeringen die voortkomen uit het niet naleven
van deze richtlijnen.

WAARSCHUWING: Om te blijven voldoen aan de FCC-richtlijnen inzake RF-blootstelling,
dient dit apparaat te worden geinstalleerd en gebruikt op een minimumafstand van 20 cm
tussen de zender en uw lichaam. Gebruik het apparaat met de meegeleverde antenne. Niet
toegelaten antennes, wijzigingen of uitbreidingen kunnen de zender beschadigen en de FCC-
voorschriften overtreden.

MPE-verklaring (Veiligheidsinformatie)

Uw apparaat bevat een zender met een laag vermogen. Als het apparaat uitzendt, wordt een
Radiofrequentiesignaal (RF) uitgezonden.

Bepalingen
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Veiligheidsinformatie

Om te blijven voldoen aan de FCC-richtlijnen inzake RF-blootstelling, dient dit apparaat te
worden geinstalleerd en gebruikt op een minimumafstand van 20 cm tussen de zender en uw
lichaam. Gebruik het apparaat alleen met de bijgeleverde antenne. Niet toegelaten antennes,
wijzigingen of uitbreidingen kunnen de zender beschadigen en de FCC-voorschriften
overtreden.

Waarschuwingsverklaring van de FCC-voorschriften op blootstelling aan
radiofrequentie

Dit draadloos LAN-zendapparaat werd geévalueerd volgens het FCC Bulletin OET 65C en
voldoet aan de vereisten zoals vastgesteld in CFR 47 Secties 2.1091, 2.1093 en 15.247(b)(4)
met betrekking tot de RF-blootstelling van radiofrequentie-apparaten. Het uitvoervermogen
van de straling van dit draadloos LAN-apparaat ligt ver onder de blootstellingslimieten van de
FCC radiofrequentie. Dit apparaat moet echter worden gebruikt op een manier dat er geen
gevaar bestaat op menselijk contact tijdens normaal gebruik als een mobiel of draagbaar
apparaat dat op het lichaam wordt gedragen. Wanneer dit apparaat wordt gebruikt, moet er
een zekere afstand worden bewaard tussen de antenne en dichtbij staande personen om

de naleving van de voorschriften met betrekking tot RF-blootstelling te garanderen. Om te
voldoen aan de RF-blootstellingslimieten die in de standaarden ANSI C95.1 zijn vastgelegd,
mag de afstand tussen de antenne en de gebruiker niet minder dan 20 cm bedragen.
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